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About this Manual

1

1	 About this Manual

Saia PCD® Supervisor is a supervisor tool for Saia PCD devices. It is based on the 
powerful Niagara V4.14 software framework and uses the Saia PCD® S-Bus over 
Ethernet. 

This manual describes how to install Saia PCD® Supervisor and configure the SaiaIP-
Network to allow Saia PCD devices data to be made accessible to the Niagara frame-
work. 

It consists of the following main sections:

2	 About Saia PCD® Supervisor 
This section gives an introduction to basic system principles and the 
Saia PCD® Supervisor user interface.

3	 Securing Saia PCD® Supervisor 
This section provides guidance on security issues to be considered when in-
stalling and using Saia PCD Supervisor.

4	 Installing Saia PCD® Supervisor 
This section describes how to install Saia PCD® Supervisor

5	 Licensing Saia PCD® Supervisor 
This section describes how to obtain and install Saia PCD® Supervisor license 
files. 

6	 Creating/Enginering a project 
This section describes the process of engineering Saia PCD® Supervisor.

6.1	 Initial Setup 
This section covers the procedures that must be followed to get Saia PCD® 
Supervisor ready for use. 

6.2	 Manual creation of data points 
This section covers the process to create communicated datapoints manually.

6.3	 Using the “Saia PG5 Data Import Wizard” 
This section covers the process to import the datapoints from the PG5 project 
using the Saia PCD Data Import Wizard.

6.4	 General functions 
This section describes general function can be used inside of the Saia PCD 
Supervisor. For example how to configure Saia PCD® Supervisor to control 
schedules times in the Saia Burgess Controls system. 

6.5	 Connect to 3rd Party Systems 
This section covers the process to import the datpoints and communicate with 
third party Devices. For example BACnet devices. 

6.6	 Creating Schematics (Operator Views) 
This section gives basic guidance on creating dynamic operator views that en-
able end users to navigate and access the system. 
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About this Manual

1

6.7	 Set Up for Saia PCD® Supervisor Users 
This section describes how to configure users in Saia PCD® Supervisor to 
ensure each user only has access to the appropriate information. 

6.8	 Backup & Restore 
This section describes how to backup/restore the Saia PCD® Supervisor con-
figuration.

7	 Using Saia PCD® Supervisor 
This section covers general day-to-day operating procedures aimed at end 
users.

It is assumed that you understand how to use Niagara V4.14. For further 
information you should refer to the Niagara documentation which is installed 
during the Saia PCD® Supervisor installation. It can be accessed from the 
Saia PCD® Supervisor Help menu.
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1

1.1	 Conventions Used in this Manual
There are numerous items and instructions in this manual, the conventions below are 
designed to make it quick and easy to find and understand the information.

	- Menu commands are in bold type.

	- Buttons, and options in dialogue box that you need to select are in bold type.

	- The names of text boxes and dialogue boxes are in bold type.

	- Key combinations that you should press appear in normal type. If joined with a plus 
sign (+), press and hold the first key while you press the remaining one(s). For ex-
ample CTRL+S indicates holding down the control key while pressing S.
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About Saia PCD® Supervisor

2

2	 About Saia PCD® Supervisor

Saia PCD® Supervisor is a supervisor tool for Saia PCD Control Systems. It is based 
on the powerful Niagara V4.14 software framework. This section describes the key 
features of Saia PCD® Supervisor and its user interface, and introduces some of the 
terminology used.

Using the supplied SaiaIPNetwork (SBC Communication Driver), Saia PCD® Supervi-
sor can connect to multiple Saia PCD devices and access device data in order to moni-
tor or adjust the operation. System data is held within a database and is accessible in 
raw format or presented in specially-designed graphical pages known as schematics or 
Operator Views (PX view).

Saia PCD® Supervisor connects to the Saia PCD devices network over Ethernet. This 
gives access to the Saia PCD devices on the associated LAN (Local Area Network) 
and through S-Bus Gateway functionality serial networked devices.

Ethernet

RS-485

PCD1.M2220-C15 
as Gateway

PCD1 E-Line programmable I/O modules

Ethernet communication to PCD’s and on PCD’s over RS-485 
which are connected behind a gateway.  

PCD7.D410DT5F
PG5 programmable 
MB Web-Panel

PCD1.M2110R1 as Sub-Station
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2.1	 Saia PCD® Supervisor Architecture
2.1.1	 Platform

In computing, a platform describes some sort of hardware architecture or software 
framework (including application frameworks), that allows software to run. Typical 
platforms include a computer’s architecture, operating system, programming languages 
and related runtime libraries or graphical user interface

The Platform is the topmost level of configuration and may be compared to the control 
panel on a PC. In this area of Saia PCD® Supervisor where you can set up: 

	- Communications
	- Install Licenses
	- Find fault issues
	- Start / Stop stations
	- Copy stations
	- Backup stations
	- Handling certificates
	- Handling Lexicons for multilingual projects
	- Checking the TCP/IP configuration of the Host computer
	- Accessing Remote File system 

Access to the Platform requires the user to login, using the same credentials required 
to login to the Windows PC. In case of some modification Passphrase is also needed. 

2.1.2	 Station
Software running on a Niagara platform that is the main unit of server processing in 
the Niagara architecture. A station runs the components of the Niagara framework and 
provides the access to view and control these components via the Workbench or web 
browser. Think of the station as the application built by the engineer to integrate the 
data and design a user interface. 

The Station manages communications with the Saia Burgess Controls system(s) and 
acts as a ‘container’ for all other configuration settings and functions. These include:

Services such as alarm listening and monitoring and the Saia PG5 Data Import 
Wizard

Drivers for managing access to data in the Saia Burgess Controls system(s) 
and other systems.

Files schematic/Operator Views used to present system information on  
remote client devices

.. many other services are possible
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Access to the Station settings requires the user to login (different to platform login). 
Initial system configuration is achieved using a default admin/engineering user account 
which is set up when the Station is created. Once configuration is complete further 
accounts can be added that grant different users specific access rights according their 
role (see 6.7 Set Up Saia PCD Supervisor Users).

2.1.3	 Platform Daemon
A program that is executed as service in the background.

In an other way it is compact executable program  that enables a user to access plat-
form tools through the Workbench. The Platform Daemon enables to run the stations 
on the local PC.

2.1.4	 SBCIpNetwork driver
The SBCIpNetwork driver defines the communication settings to a Saia Burgess Con-
trols system and provides access to data held in its controllers and devices, including:

Points Input, Output, Register, Flag, Timer, Counter, DataBlock and text Block. 
Histories values logged in HD log modules.
Alarms for monitoring alarm messages generated within the  

Saia Burgess Controls system.

2.1.5	 Other Drivers (open points)
The Saia PCD® Supervisor is based on the Tridium Niagara V4.14 framework. There-
fore it supports a wide range of additional drivers, suitable for interfacing with other 
manufacturer’s building automation systems and products. This enables the monitor-
ing and control of these systems to be fully integrated with the management of a Saia 
Burgess Controls system within a common supervisor.

Support for other drivers requires one or more additional open driver packs. For de-
tails of order codes and point counts refer to the Saia PCD® Supervisor Data Sheet 
(34-001_DS_Saia-PCD-Supervisor). 

	● such an open driver can be: BACnet, Modbus etc.
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2.2	 User Interface Application (Host PC)

This section introduces the main features of the Saia PCD® Supervisor user interface.

Nav Tree

Locator Bar

Palette

View Changer

View Pane

Menu Bar
Tool Bar

2.2.1	 Nav Tree (navigation panel)
The Nav tree (or navigation panel) provides navigation around the elements, folders 
and files in Saia PCD® Supervisor. It is configurable under “user” by “user”. Once con-
figured, you can view devices and points in a Saia Burgess Controls system.

For help on using the Nav tree, refer to chapter 7.2.2.2 Nav Tree.

2.2.2	 Palettes
 It is a collection (or library) of components in a hierarchical view that can be copied 
and pasted where needed – Wire Sheet, Property Sheet, Px View or Palette side bar. 

Palettes are useful when configuring certain elements in the system. There are many 
Palettes available, but the most commonly used in Saia PCD® Supervisor are:

•	 Alarm ................................ for configuring Alarm handling
•	 Schedule .......................... for configuring Time Schedules
•	 History .............................. for configuring Histories (Plots)
•	 kitControl .......................... for creating control logic in Saia PCD® Supervisor 
•	 bajaui................................. for configuring Graphics and accessing default images 
•	 kitPx................................... for configuring Graphics and accessing default images 
•	 kitHVAC............................. for configuring Graphics and accessing default images 
•	 kitPxN4Svg........................ for configuring Graphics and accessing default images 
•	 WebChart.......................... for configuring Graphics and accessing default images 
•	 SBCOfflineEngineering..... service to import easily resources of a Saia PCD device  

                                           from PG5 project
•	 sbc..................................... for devices and points 
•	 sbcIconGallery................... for images to build user screens 
•	 honBACnetUtilities............ for getting detailed information of BACnet points. 

For help on opening and closing Palettes, refer to chapter 7.2.2.3 Palettes
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2.2.3	 Locator Bar
There is a fundamental navigation model in the Workbench which is similar to the URL 
navigation used in the Web browsers.

When the URL is changed the URL referenced content is shown in the browser. A re-
membered history of the URLs is allowing back & forward navigation. 

The ORD (Object Resolution Descriptor) is the universal identification system of Niaga-
ra and it is used throughout the Niagara framework. It unifies and standardizes access 
to all information. And it is designed to combine different naming systems into a single 
string.

The ORD can be: 
absolute station:|slot:/Drivers/SBC$20Systems/SBCIpNetwork_Demo/Device1/

points/Heating1/Outside/Temperature/PhysVal”
relative slot:Outside/Temperature/PhysVal”

The locator bar provides similar functionality to the Nav tree. As you navigate around 
the file system the locator bar will update to show the current location and view. It 
shows the ORD (Object Resolution Descriptor)

For help on using the locator bar, refer to chapter 7.2.2.4 Locator Bar

2.2.4	 View Pane & View Changer
The view pane is the principle work space for Saia PCD® Supervisor. When you first 
run Saia PCD® Supervisor it will display the home page (shown above). As you navi-
gate through the system and select different items in the Nav tree, the view pane will 
change to show different information or configuration pages. 

Some elements may provide more than one type of view. For help on selecting the 
required view, refer to chapter 7.2.2.5 View Pane & View Changer
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2.2.5	 Client Devices
Saia PCD® Supervisor can be accessed via web clients while an IP connection is pos-
sible between the client device and the PC running Saia PCD® Supervisor.

Once accessed Saia PCD® Supervisor via Web client, it provides a similar user experi-
ence to the user as when it is accessed on the main PC depending on the device being 
used to access. The Web Server - Client connection can use JAVA or HTML5.
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3	 Securing Saia PCD® Supervisor

3.1	 Introduction
The purpose of this section is to provide the information necessary for those involved 
in the installation and maintenance of a product or system to understand the require-
ments for configuring and managing the security of the product or system.

General Security Best Practice for Saia Burgess Controls IP Based Product manuals 
„26-776_Manual_TCP-IP-Ethernet“ and „26-867_Manual_TCP-IP-Enhancements“.

Both documents are available from the Saia Burgess Controls support web site 
www.sbc-support.com.

3.2	 Disaster Recovery Planning
It is a documented process or set of procedures to recover and protect a business IT 
infrastructure in the event of a disaster. Such a plan, specifies procedures an organiza-
tion is to follow in the event of a disaster. 

When developing the disaster recovery plan ensure that it includes ALL data required 
to restore system operation, including:

	- Configuration files for platform(s) and station(s)

	- Database objects 

	- License and certificate files

	- Station Backup

	- Station Copies

See book 27-651 chapter 6.8	 Backup & Restore for details.

3.3	 Physical and Environmental Considerations 
The PC running Saia PCD® Supervisor should, where possible, be secured against 
unauthorised physical access.

3.4	 Security Updates and Service Packs
Ensure the PC running Saia PCD® Supervisor and any client devices have the latest 
operating system updates installed, and the latest version of Saia PCD® Supervisor is 
being used.

Saia Burgess Controls software is tested against the latest service packs and up-
dates applicable at the time of release. For significant operating system and Java 
updates / service packs, please check the Saia Burgess Controls support web site 
www.sbc-support.com for any compatibility issues.

http://www.sbc-support.com
http://www.sbc-support.com
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3.5	 Virus Protection
Ensure the PC running Saia PCD® Supervisor and any client devices are running virus 
protection software, and the virus definitions are kept up-to-date.

Some virus protection software may have an adverse impact on the performance of 
Saia PCD® Supervisor. In such cases request that the Saia PCD® Supervisor directory 
be excluded from on-access scan.

Further details can be found on the Saia Burgess Controls support web site 
www.sbc-support.com.

3.6	 Network Planning and Security
It is recommended that the Ethernet network used by the Building Management Sys-
tem (BMS) is separated from the normal office network using an air gap (separated wir-
ing and devices or layer 3 switches or virtual private network (VPN)). Physical access 
to the Ethernet network infrastructure must be restricted. You must also ensure that the 
installation complies with your company’s IT policy.

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider 
of security products is recommended for any Saia PCD® Supervisor installation. Fol-
low best practice for the products chosen as well as any corporate IT policy where the 
installation is made. Lock down the products to the particular port you’ve configured for 
Saia PCD® Supervisor HTTPS and HTTP.

Always follow the guidelines PDF-Documents:

manual.......................................... 26-776_Manual_TCP-IP-Ethernet 
manual.......................................... 26-867_Manual_TCP-IP-Enhancements.
manual.......................................... 26-620_Manual_Security-Rules
manual.......................................... NiagaraAX Hardening Guide
instruction..................................... 30-002_Internet-Security-Instructions_SBC
instruction for using VPN router... 30-004_VPN-Router

 
You must also take steps to ensure the security of any other networks connected to 
Saia PCD® Supervisor (e.g. BACnet).

3.7	 Virtual Environments
Follow best practice for the products chosen as well as any corporate IT policy where 
the installation is made. 

http://www.sbc-support.com
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3.8	 Securing Wireless Devices
If a wireless network is being used it must be secured according to your company’s IT 
policy.

3.9	 System Monitoring
For any Saia PCD® Supervisor installation, especially when connected to the internet, 
Saia Burgess Controls recommends the use of an Intrusion Detection System (IDS) 
from a reputable provider of security products. Follow best practice for the products 
chosen as well as any corporate IT policy where the installation is made.

Saia PCD® Supervisor logs (Audit History) changes made to its own configuration 
and adjustments to the Saia Burgess Controls control system. Many IDS and firewall 
products offer a complete solution for recording all the traffic coming in and out of the 
Saia PCD® Supervisor PC, providing users with the ability to record all activity at the 
lowest level.

3.10	 Securing Access to the Operating System
Ensure the PC running the Saia PCD® Supervisor and any PCs used for Saia PCD® 
Supervisor clients are secured according to your company’s IT policy.

3.11	 Access Control
All Saia PCD® Supervisor files should be protected from read and write access by 
people and software not authorized. Saia Burgess Controls recommends following best 
practice for securing system objects, such as files, and using access control appropri-
ately.

If Windows users are granted access to the filing system location of the Saia PCD® Su-
pervisor project then it is possible for them to inadvertently (or deliberately) open, de-
lete or edit any of the configuration and data files of independently of their Saia PCD® 
Supervisor workgroup settings.
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3.12	 Securing Saia PCD® Supervisor 
The Saia PCD® Supervisor software should be configured during installation and 
operation following best practice. Follow the installation procedure as described in this 
manual. In addition, refer to the Niagara 4 help system and Niagara 4 security guide-
lines.

3.12.1	 Default Admin User of a Station
Initial system configuration is achieved using a default admin/engineering user account 
which is set up with a strong password when a Station is created. 

3.12.2	 Passphrase

The passphrase, specified during the Saia PCD® Supervisor installation process, pro-
tects sensitive data on any station that you create and will be required if the Saia PCD® 
Supervisor station is to be moved to another PC e.g. moved to the site PC, or restored 
after a PC failure. 

3.12.3	 Set up Other Users for the Station
Once configuration is complete (using the default admin user) further user accounts 
must be added that grant different users specific access rights according their role. 
Saia PCD® Supervisor enforces the use of strong passwords. 

For further details, see book 27-651 chapter 7 Using Saia PCD® Supervisor
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3.13	 Setting up Google 2 factor authentication
The Google Authentication Scheme is a two-factor authentication mechanism that re-
quires the user to enter their password as well as a single-use token when logging in to 
a station. This protects a user’s account even if their password is compromised. 

This authentication scheme relies on TOTP (Time-based One Time Password) and the 
Google Authenticator app on the user’s mobile device to generate and verify single-use 
authentication tokens. Google authentication is time based, so there is no dependency 
on network communication between the user’s mobile device, the Station, or external 
Servers. Since the authenticator is time based, the time in the station and time in the 
phone must stay relatively in sync. The app provides a buffer of plus or minus 1.5 min-
utes to account for clock skew.

Prerequisites: 
	■ The user’s mobile phone requires the Google Authentication app. 
	■ You are working in Workbench. 
	■ The user exists in the station database.

Perform the following steps: 
1.	 Open the GAuth palette and add the GoogleAuthenticationScheme to the Ser-

vices > Authenticationservice node in the Nav tree.

2.	 Right-click Userservice, and double-click the user in the table. 
The Edit view for the user opens.

3.	 Configure the Authentication Scheme Name property to GoogleAuthenticationScheme and 
click Save.

4.	 Click the button next to secret Key under the user’s authenticator and follow the 
prompts. 

5.	 To complete the configuration, click Save. 
Depending upon the view you are using, you may have to open the user again or 
refresh after saving. 
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3.14	 Saia PCD® Supervisor Security Check List
	� Latest version of Saia PCD® Supervisor is being used.

	� Saia PCD® Supervisor installation files, configuration files (including station back-
up), certificates and licenses are included in disaster recovery plan.

	� The PC running Saia PCD® Supervisor should, where possible, be secured against 
unauthorized physical access.

	� The Ethernet network (and any other networks) that the PC is connected to is se-
cured, e.g. by the use of firewalls and intrusion detection systems.

	� The PC is running the latest version of the Windows operating system, with all 
updates and service packs.

	� The PC is running virus protection software.

	� Appropriate user accounts are set up on PC and access to files is restricted to only 
those who are authorized.

	� Saia PCD® Supervisor is configured to use HTTPS using a certificate from a trust-
ed Certificate Authority.

	� Saia PCD® Supervisor users are configured as required.

	� Ensure Saia PCD® Supervisor is configured to backup data regularly to a secure 
location as per your company’s backup policy.
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3.15	 General Data Protection Regulation (GDPR)
The General Data Protection Regulation (EU) 2016/679 (GDPR) is a regulation in EU 
law on data protection and privacy for all individual citizens of the European Union (EU) 
and the European Economic Area (EEA). It also addresses the transfer of personal 
data outside the EU and EEA areas. The GDPR contains provisions and requirements 
related to the processing of personal data of individuals (data subjects) inside the EEA, 
and applies to any enterprise established in the EEA or (regardless of its location and 
the data subjects’ citizenship) that is processing the personal information of data sub-
jects inside the EEA.

Under the terms of the GDPR personal data includes any information that may be used 
to identify an individual. This includes (but is not limited to):

	■ user names,
	■ passwords,
	■ phone numbers,
	■ email addresses,
	■ work or residential addresses.

Any such information entered into Saia PCD® Supervisor is encrypted and stored 
on the PC where the Saia PCD® Supervisor application is installed on a customer’s 
premises. Neither Honeywell or Saia Burgess Controls have any involvement with the 
storage and/or processing of personal data within Saia PCD® Supervisor.

Responsibility for compliance with the requirements of the GDPR lies fully with the sys-
tem integrator or system administrator and, as such, they must ensure that adequate 
technical and organisational systems are in place to:

	■ obtain explicit consent from each data subject for personal data to be stored, used 
and/or processed,

	■ allow individuals to have access to their personal data in order to verify accuracy,
	■ allow individuals to withdraw their consent at any time and to have their personal 

data to be permanently erased,
	■ maintain the security and integrity of data storage and access at all times,
	■ report any breaches of data security (that may affect user privacy) to the relevant 

authority within 72 hours of the breach occurring. 
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4	 Installing Saia PCD® Supervisor

This section describes how Saia PCD® Supervisor should be installed to ensure that it 
operates correctly. The following steps are required to install Saia PCD® Supervisor:

4.1	 Installation Requirements

4.2	 Obtaining the Saia PCD® Supervisor Software

4.3	 Installing the Saia PCD® Supervisor Software

4.4	 Installing the Platform Daemon

4.5	 Configuring the Windows Firewall
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4.1	 Installation Requirements
Before installing, or upgrading, ensure that the PC meets the system requirements. 
Refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

The PC on which Saia PCD® Supervisor is to be installed must have TCP/IP access to 
the Saia Burgess Controls network.

4.2	 Obtaining the Saia PCD® Supervisor Software
Navigate to the Saia Burgess Controls Technical Support web site at  
http://www.sbc-support.com --> Software / Saia PCD® Supervisor

http://www.sbc-support.com
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4.3	 Installing the Saia PCD® Supervisor Software
1.	 Log in to the PC as someone with Administrator rights. 

It is recommended that you close all other programs before installing 
Saia PCD® Supervisor. However, do not close any virus protection soft-
ware.

2.	 Presently the installer works from the local hard drive only. Therefore the installer 
must be copied to a local folder first (e.g. C:\Temp)

3.	 Run ‘Installer_x86.exe’ (for 32-bit operating systems) or  
‘Installer_x64.exe’ (for 64-bit operating systems), and  
wait for the first installation screen to appear. 
 

 

4.	 Follow the on-screen instructions 
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Read and accept the license agreement. 
 

 

5.	 Change the destination folder (if required). The default path is  
"C:\SBC\SaiaPCDSupervisor". 
 

If you enter a new path it must not contain spaces
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6.	 Add shortcuts to the Start Menu and Desktop. 
 

7.	 Once the installation is complete the following screen is displayed. 
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During the installation you will be prompted to create a passphrase which 
ensures sensitive data on any station that you create  is protected. En-
sure that you remember it and keep it safe as it will be required to move 
the configured Saia PCD® Supervisor to another PC.

Leave all three check-box checked and click the 
Finish button. Then the software is installed and two 
icons are placed to the Desktop

4.4	 Installing the Platform Daemon
If there are other instances of Saia PCD® Supervisor (or Niagara) on the same PC then 
the Platform Daemon must be installed. This will typically be set up during the installa-
tion process. It can also be installed and run manually.

1.	 Click Start and choose All Programs.

2.	 Navigate to the Saia PCD Supervisor folder.

3.	 Click Install Platform Daemon.

After a few seconds a command window should briefly appear with the following mes-
sage:

To check if the Platform Daemon is already running go to
	 Windows Control Panel  Administrative Tools  Services   
	 Niagara Services running

The running Niagara service can block communication ports depending on what type 
of communication is configured.



4-7

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Configuring the Windows Firewall

Installing Saia PCD® Supervisor

4

4.5	 Configuring the Windows Firewall
You may need to configure the Windows Firewall to allow Saia PCD® Supervisor to 
communicate correctly.

To configure the Windows Firewall
1.	 Open the Windows Firewall. 

- In Windows 10 or 8, type ‘Windows Firewall’ in the Search box
- In Windows 7, click the Windows Start button, type ‘Windows Firewall’ in the 

Search box.
- Click Windows Firewall from the list of search results.

2.	 Click Allow a program or feature through Windows Firewall. The Allowed pro-
grams and features list is displayed. 
 

3.	 Scroll down the list and check that entries exist for Niagara Runtime Launcher, 
Niagara Station Launcher, and Niagara Workbench for your Saia PCD® Supervisor 
installation folder. If these programs do not appear in the list you will need to add 
them (see procedure below). 
 

Each installed instance of Niagara requires its own entries in the Firewall 
settings.

4.	 If you need to change any settings click Change settings and edit the checkboxes 
as required.



4-8

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Configuring the Windows Firewall

Installing Saia PCD® Supervisor

4

To add programs to the firewall:
1.	 Open the Allowed programs and features list as described above.

2.	 Click Change settings.

3.	 Click Allow another program. The Add a Program dialogue box is displayed. 
 

4.	 Click Browse and navigate to the Saia Burgess Controls Control Systems | 
Saia PCD Supervisor | bin folder.

5.	 Double click the program to be added.

6.	 To add Niagara Runtime Launcher select nre.exe

7.	 To add Niagara Station Launcher select station.exe

8.	 To add Niagara Workbench select wb_w.exe

9.	 The program will appear highlighted in the Add a Program dialogue box. Click 
Add to add the program to the firewall list. The dialogue box will close.

10.	 Repeat steps 3 through 6 to add the other programs.
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5	 Licensing Saia PCD® Supervisor

Before Saia PCD® Supervisor can be used, it must be licensed. The license will allow 
you to run the application on a single PC. 

5.1	 Obtain a Saia PCD® Supervisor License and Certificate
When an unlicensed installation of Saia PCD® Supervisor is run you will be prompted to 
email certain details to Saia Burgess Controls in order for them to provide the relevant 
license and certificate files.

To obtain a license: 
1. Launch the Saia PCD® Supervisor ap-

plication, e.g. from the Start menu point 
to All Programs > Saia Burgess Con-
trols Systems > Saia PCD® Supervisor 
and then click Saia PCD® Supervisor. 
The Request License dialogue box is 
displayed. The pop up pictures shows 
you the so called Host ID of the com-
puter. The Host ID is strictly connected 
to that hardware of the PC. If the hard-
ware is changed a new license must be 
obtained.

2. Email the requested information (list what is required….) to your local sales office 
including the email address you would like the license files sent to.

3. Click Exit to close the dialogue box.
 
The Order Management Team will process your request, and email the license and 
certificate files to the specified email address.

5.2	 Install the Saia PCD® Supervisor License
Your Saia PCD® Supervisor license is mailed to you as a ZIP file containing a num-
ber of license and certificate files which need to be installed on the PC containing 
Saia PCD® Supervisor, this can be done in two ways:

5.2.1	 Automatic Licensing

5.2.2	 Manual Licensing
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5.2.1	 Automatic Licensing

Saia PCD® Supervisor can be licensed automatically via the 
global license server providing the PC has internet access. 
If this is the case when Saia PCD® Supervisor is run after 
your license request has been processed it will automati-
cally be licensed and the files copied to the required folder.

5.2.2	 Manual Licensing
To install the license and certificate files:

1.	 Copy the ‘Licenses.zip’ file to the PC hard disc.

2.	 Extract all the files from ‘Licenses.zip’ to an empty folder. The folder should now 
contain six files.

3.	 Copy the three ‘.license’ files to the  
  “C:\SBC\SaiaPCDSupervisor\security\licenses” folder.

4.	 Copy the three ‘.certificate’ files to the  
  “C:\SBC\SaiaPCDSupervisor\security\certificates” folder.

5.	 You will now be able to launch the Saia PCD® Supervisor (Workbench) application.

5.3	 Updating a License
If you purchase a license upgrade, e.g. for additional points, you will be emailed the 
updated license files as a ZIP file containing a number of license and certificate files 
and it will be necessary to upgrade the Saia PCD® Supervisor license. If the Saia PCD® 
Supervisor PC PC is connected to the internet this should happen automatically - see 
chapter 5.2.1 Automatic Licensing, alternatively the files can be copied manually - 
see chapter 5.2.2 Manual Licensing.
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6	 Creating/Engineering a project (application, site, ..)

Building a site within Saia PCD® Supervisor involves creating a database that reflects 
the structure, devices and points within the associated Saia Burgess Controls system. 
In the Saia Burgess Control System mainly the S-Bus communication protocol is used. 
However it is possible to use third party communication protocols depending on the 
used license. A Point in the Saia PCD® Supervisor represents a value or state of an 
item in the Control System (e.g. a point represents a value or state of a symbol from 
the PCD controller). 

For example:  
“Outside_Air_Temperature_Sensor_Value” is the point name in the Saia PCD® Supervi-
sor, but it is actually communicated as “Register 100” from the proper PCD device. 

The communication connection is based on Media type and Media address  
("Register 100") not on the symbol name.

There are two methods to build up the point database within Saia PCD® Supervisor: 

•	 Manual creation of data points
•	 Using Saia PG5 data import wizard

You can use either one or both methods to build up your point database, according to 
your requirements.

It is the best practice to only add the points required for use in the Saia PCD® Supervi-
sor. Adding unwanted points will increase the memory usage and affect the remaining 
license count. Keep in mind that the points for HDLogs are imported to get it working 
properly.

Go to ..

6.1	 Initial Setup

6.2	 Manual creation of data points

6.3	 Using the “Saia PG5 Data Import Wizard”

6.4	 General functions

6.5	 Connect to 3rd Party Systems

6.6	 Creating Schematics (Operator Views)

6.7	 Set Up Saia PCD® Supervisor Users

6.8	 Backup & Restore
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6.1	 Initial Setup
When Saia PCD® Supervisor is run for the first time you will need to work through an 
initial setup procedure which involves the following steps:

6.1.1	 Launch the Saia PCD® Supervisor Application
1.	 Click Windows Start button and choose All Programs.

2.	 Navigate to the Saia PCD® Supervisor and open it.  

3.	 Click Saia PCD® Supervisor. The Saia PCD® Supervisor application window will be 
opened. This program is called as Workbench in relation of Niagara N4 environment. (It 
can happen that the start of the program takes a bit more time, please be patient.)
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6.1.2	 Open the Platform
1.	 In the Nav tree of the Saia PCD® Supervisor tree right-click on MyHost and choose 

Open Platform. The Connect dialogue box is displayed. 
 

 
 

	  

2.	 In the Type box select Platform TLS Connection. Leave other settings at their 
default values.

3.	 Click OK. The Authentication dialogue box is displayed.

 
 

If a ‘Cannot display page’ error appears, ensure that the Platform Dae-
mon has been installed. 
See chapter “4.4 Installing the Platform Daemon"
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4.	 Enter the Username and Password that you would normally use to login to the 
Windows PC. 

For security it is recommended that the Remember these credentials box 
is left unchecked.

5.	 Click OK.  
A “Platform” item will now appear in the Nav tree and various platform objects will 
appear in the view pane. 
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6.1.3	 Create a New Station
1.	 From the Tools menu select New Station. The New Station Wizard is displayed. 

 

   

2.	 Under Station Templates click SaiaPCDSupervisor.ntpl to highlight it.

3.	 Type a suitable name in the Station Name box.

If a station already exists with that name you will be prompted to delete 
the existing station or you can go back and specify an other name for 
your new Station. You must select Yes to proceed.
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4.	 Click Next. 
 

 

5.	 Type a password in the Password for admin User box. 
 

The password must have a minimum of 10 characters and include at 
least one capital letter, one lowercase letter and one numeral (digit).

 
As example: 
	 username:	 admin 
	 password:	 Manager123  (it can be later changed) 
Retype the password in the Confirm Password for admin User box. 
 

This password is for the ‘admin’ and should be reserved for engineers. It 
grants access to everywhere and to everything inside of a Station.

6.	 Select the copy it to secure platform for “localhost” with Station Copier option.

7.	 Click Finish.

8.	 If you have not already logged in to the Platform the Authentication dialogue box is 
displayed, go to step 10  
 

 
If you have already logged into the Platform, go to step 11.
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9.	 Enter your Username and Password (login credentials of the PC) and click OK.

10.	 If a station with the same name already exists, you will first be prompted how to 
proceed. 
 

11.	 Specify the required option. 

12.	 Click Next. A dialogue box enabling you to specify the start-up options is displayed. 
 

 

13.	 Select the required start-up options. 
 
START AFTER 
INSTALL

Select this option if you want to start the station as soon as 
it has copied (recommended).

AUTO-START Select this option if you want the station to be started when 
the PC is restarted (recommended).

 
When developing several Supervisors other stations will need to be 
stopped.

 

14.	 Click Next. 
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15.	 Click Finish. A progress update is displayed. 
 

 

16.	 When the process is complete, click Close. The Open Application Director dialogue 
box is displayed. 
 

 

17.	 Click Yes. The Application Director is displayed. Check that a ‘Station Started’ mes-
sage is shown. 
 



6-9

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Initial Setup

Creating/Engineering a project

6

6.1.4	 Open the Station
1.	 In the Nav tree right-click on MyHost and select Open Station. The Connect dia-

logue box is displayed. 
 

 

2.	 In the Type box select Station TLS Connection. Leave other settings unchanged.

3.	 Click OK.  
The Authentication dialogue box is displayed with the default ‘admin’ user  
selected. 
 

admin

Manager123

 

4.	 Type the appropriate password in the Password box (i.e. the password specified 
when the Station was created). 
 

For security it is recommended that the Remember these credentials box 
is left unchecked.

 

5.	 Click OK 
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6.	 After a short delay, the chosen station name will appear in the Nav tree and the 
view pane will show a summary of Station parameters (Station Summary view): 
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6.1.5 	 Increase the memory space assigned to Workbench and station
In order to obtain enhanced performance and handle multiple devices, user need to 
increase the reserved memory space assigned to the Workbench and station.

1.	 Go to the installer location. 
2.	 Open the SaiaPCDSupervisor folder and then open the etc folder. 

 

3.	 Open nre.properties file. 
 

4.	 Update the memory space reserved for the Station in the second last line to  
station.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M. 

5.	 Update the memory space reserved for the Workbench in last line to 
wb.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M.
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6.2	 Manual creation of data points
This chapter describes the manual creation of the point database. 

The following steps are needed to create the data point:

1.	 Add a Saia Burgess Controls Driver (it is named as “sbc” in the Palette)

2.	 Configure the driver

3.	 Add device(s) manually (mainly PCD or other S-Bus communicating devices) 

4.	 Add the required points to the database. Take care of the conversion. Building au-
tomation mainly using integer numbers multiplied with factor 10 in the PCD control-
ler. While Saia PCD® Supervisor is using normalized floating point. 

5.	 Check (or modify if necessary) the speed of the communication of the point 

This is a tedious process with the possibility to make mistakes easily. However it is 
advantageous for every System Integrator to understand the process. 

It makes sense to arrange a PCD controller - connected to Saia PCD® Supervisor - with 
a simple user program to follow up the explanation.

The user program can be for example a simple PCD device with media mapped  
PCD3.S100 Workshop Simulator Unit. (Who does not understand this sentence please 
go through the SBC PG5 User Manual or better to take part of a Basic SBC PG5 work-
shop.)

Important: The communication connection is based on “Media type” + “Media Address” 
(e.g. Register 100). Best practice is to use explicit addressing (so called “hard address-
ing”) in the PCD controller. Dynamic addressing can be also used (makes no so much 
sense) but the System Integrator must understand, that the dynamically allocated ad-
dresses in the PG5 can be any time overwritten by the PG5 programming tool.

From SBC V3.0 onwards, the default Data Point View changes from 
Hon BACnet View (Web application View) to Hon Data Point View (UX/
HTML5). Different views still can be selected by choice.

 

6.2.1	 Add a Saia Burgess Controls driver (SBCIpNetwork)
We need to define at least one SBCIpNetwork for S-Bus over Ethernet communicated 
devices. Under the SBCIpNetwork driver many PCD devices can be configured to com-
municate with. It is possible to define other SBCIpNetwork networks in order to distrib-
ute the PCD devices better and decrease the load of each SBCIpNetwork. 

The Saia Burgess Controls Driver controls the communications and flow of data to and 
from the PCD devices.

It is possible to communicate with serial S-Bus networked devices using the SBC  
S-Bus gateway function in the PCD controllers.
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On larger sites it may speed up data transfer to utilise two or more separate SBC 
S-Bus drivers (SBCIpNetwork)

 

6.2.1.2	 Create a folder for Saia Burgess Controls Driver 

1. In the Nav tree open the Station folder. 

2. Open the Config folder. 

3. Right-click on Drivers and select New > Folder. The Name dialogue box is dis-
played. 
 

 

4. Type SBC and click OK. The new folder will appear in the Nav tree. 

5. Right-click the SBC folder and select Rename. The Rename dialogue box is 
displayed.  
 

 

6. Type SBC Systems and click OK. 
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6.2.1.3	 Add the Saia Burgess Controls Driver 

1. In the Nav tree open the Station folder.

2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers 
(Driver Manager). 

4. Click on the New button. The New dialogue box is displayed.

5. In the Type to Add box select ‘SBCIpNetwork’.

6. Click OK. The following dialogue box is displayed

Do not rename the SBCIpNetwork if you are using or want to use the 
Saia PG5 Import Wizard.
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7. Click OK. The Driver Manager will now show the Saia Burgess Controls driver.

8. Right-click the driver and select Cut.
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9. In the Nav tree, right-click the SBC Systems folder and select Paste.

It is possible to create folder to the points to make nicer structure. 
However when the Saia PG5 Data Import Wizard is used the default 
SBCIpNetwork folder is generated. This folder can be renamed. The 
next import then will be done to the renamed folder. The target folder 
of the import can not be freely chosen.

10. In the Nav tree, right-click to the SBCIpNetwork_Demo in the SBC Systems 
folder. 

11. You now need to configure the communications of (each - if you have many) 
Saia Burgess Controls Driver.

6.2.1.4	 Duplicated physical device
During import of a PG 5 project for each physical Saia PCD® controller device one de-
vice note will be added in the Saia PCD® Supervisor below the SBCIpNetwork Network 
driver.

It is possible to have the same physical Saia PCD® controller device duplicated below 
the imported SBCIpNetwork driver network or to have the same physical device used in 
different SBCIpNetwork drivers on the Saia PCD® Supervisor station.

For constellations to have one physical Saia PCD® controller device present several 
times below SBCIpNetwork drivers in the Saia PCD® Supervisor you should not exceed 
5 instances on the Saia PCD® Supervisor per physical Saia PCD® controller device.
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6.2.2	 Configure the Saia Burgess Controls Driver(s)
Saia PCD® Supervisor connects to the Saia Burgess Controller network (Ethernet 
networked PCD devices) using S-Bus over Ethernet communication. It is necessary 
to configure Saia PCD® Supervisor with the IP Address (or hostname) and the S-Bus 
station address of the device to communicate with. Inside of the PCD device the Media 
can be addressed by specifying the type and memory slot. 

At this point it is recommended to have a Saia PCD® device (a controller with the cor-
rect application running inside, with the correct Ethernet parameters set in the PCD and 
also in the PC) connected to the Saia PCD® Supervisor.

In the Nav tree right-click on the Saia Burgess Controls driver (e.g. SBCIpNetwork_
Demo) and choose Views > AX Property Sheet. The view pane will show a list of driver 
properties:

Basically the default parameters are good for starting. 

The driver must be enabled. Status must be OK. It can happen that the status at the 
beginning is “down” it will be “ok” right after the communication is established with the 
SBC Device.
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6.2.3	 Adding Device to the Saia Burgess Controls Driver(s) 
Each physical networked SBC controller needs at least one PCD (device) added to the 
Saia Burgess Controls Driver (SBCIpNetwork_Demo) with unique name.

1.	 Open the Palette sidebar if it not yet opened.  
Menu bar → Window menu → Sidebars → Palette

2.	 Open the “sbc” palette. 
 

3.	 Copy PCD from palette. Right click to PCD and select copy.

4.	 Right mouse click to the driver “SBCIpNetwork_Demo” and paste it.

5.	 Name it as Device1 (- or CPU1 - or respectively to the app running in the device 
e.g. AHU1 as Air Handling Unit 1).
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6.	 Double click to the Device 1 will bring up the following screen. 
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7.	 Setup the IP address and the S-Bus Station ID of the Device 1 
The Device1 must be enabled.  
Keep the default parameters in. 
 

 
 

The FTP credentials and HTTP password need to be manually config-
ured here. If these credentials are missing, then the HDLog and Alarm 
data retrieval are not working. 

 
The status can be OK or Down. When it is OK the communication is well estab-
lished. When it is down it can happen that he initial telegrams were not correct 
answered (wrong IP or S-Bus station number). Check and correct - if needed - the 
settings. Save the settings. Press the Refresh button at the bottom of the page. 
 
Disable the Device and save the settings. Enable the Device and save the settings. 
These actions are initiating telegrams which must be answered by the Device. 
Navigate to the Device Information. This will surely initiate telegrams to be sent 
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in order to get back the basic information of the connected Device. After that the 
“Status” of the Device must be OK. If not the parameter settings is not correct, or 
the Device is not correctly connected to the network. Try to ping the Device (keep 
in mind that the Windows firewall can block the ping). Step by step check of the 
settings in the SBC Device and also in the Saia PCD® Supervisor is needed.  
 
Last step is to restart the Platform Daemon,   
See chapter 4.4	 Installing the Platform Daemon 
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6.2.4	 Add Points to the Device to get the data from the PCD
First of all it is not possible to “Discover” the points from the PCD device. 

The points must be added manually.

Let us create a “SBCRegister” and some “SBCFlag” type of points.

1. Navigate to the Points folder of the Device1. It is empty.

2. Navigate to the Palette → sbc → Points. In this folder there are templates for 
every each possible type of points. This means these type of variables can be 
found inside of the SBC Device depending on the user program. The template 
points are nicely colored so it is easy to distinguish the different types.

3. Drag the “SBCRegister” type from the Plaette “sbc” and drop it to the Device1/
Points folder. In the pop-up window name it “AnalogInput_1” 

Name it in such a way that it will connect here the physical analogue input 1 of 
the PCD3.S100 workshop module. Of course there is a corresponding program 
downloaded to the PCD device.
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4. The address has to be set for that point. In this case, the first analogue input of 
the selected Device is mapped to the Register 100. (In this application this is a 
potentiometer of the PCD3.S100 simulator unit) 

1.	 Double click to the AnalogInput_1.
2.	 Open the Proxy extension.
3.	 Setup the Memory Address to 100.
4.	 Data Format can be as it was “Signed Integer”.
5.	 Save it. 

 

 

5. The Status must be {ok}. It can be seen that the “Read Value” and the “Out” are 
following the content of the “Device1/Register 100”.
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6. The Conversion is set automatically to 0.1. The Conversion is set to Linear 
and the Scale is set to 0.1. This will remove the 10 multiplication factor we use 
conventionally in the Building Automation. This scaling can be seen on the 
“Read Value” and the “Out”.

 
 
It is possible to set the Engineering Unit, precision, and the limits of the value, in 
the Facets. 
 

 

7. For the SBCFlag types. Copy the “SBCFlag” type of point from the Palette. 
Right click to the Device1/Points folder. Select “Paste Special”.



6-25

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Manual creation of data points

Creating/Engineering a project

6

8. In the pop-up set the “Number of copies” to 8. Other settings must be un-
touched.

9. 8 points are generated with the name “SBCFlagx”

10. I want to change the names of the generated points. Select the points. Right 
click to the selection. Select rename from the context menu. Fill up the “Search 
for” and the “Replace with” fields. Press ok.

11. Right click to the “Points” folder of the Device1  Views  AX Property Sheet

12. Setup the address of each “DigitalInput_” points.
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13. The Status must be {ok}. The “Read Value” and the “Out” of the generated 
points are following the content of the Flag 100 to 107 of the Devcie1.

The same way it is possible to create every needed points and connect it to the corre-
sponding media element of the Saia PCD® device.

Remember that Saia PCD® Supervisor is licensed for use up to a specific number of 
points. It is good practice to only add points that are actually required. Adding points 
that won’t be used by Saia PCD® Supervisor will not only waste resources but also 
generate unnecessary extra network traffic.

6.2.5	 Add Alarming to a data point in the Saia PCD® Supervisor
In the Saia PCD® Supervisor there is an Alarm Service which can be used to set Alarms 
for individual datapoints, regardless if the datapoint is considered alarm or not at the 
start of the engineering.

For example the Outside Air Temperature can generate an alarm when it goes under 
–20°C. For that we need to set the monitoring in the Saia PCD® Supervisor. So the 
Alarm is generated in the Saia PCD® Supervisor not in the PCD controller.

There is an other way of alarming, which is described in details later in this manual. 
The Alarms are generated in the PCD Device and the Saia PCD® Supervisor takes 
these alarms over. 
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6.2.5.1	 Steps to set alarming to a datapoint
1.	 In the Nav tree open the 127.0.0.1/Station(Demo_Station)/Config/Services folder. 

And double click to the AlarmService. 
 

 
 
 The default view (Wire Sheet) will be displayed with the default settings. (Alarm Db 
Config, Default Alarm Class and the Console Recipient). 
 
The Default Alarm Class is already used for system alarms (for those alarms which 
is generated in the Saia PCD® Supervisor). Most of the cases we do not want to 
see the Supervisory system generated alarms together with the alarms which is 
coming from the controlled process.  So we need a new alarm class to be placed. 
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2.	 Place a new alarm class to the Wire Sheet from the palette. It can be named as 
you it is proper. (here it is named Critical Alarms)  
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3.	 There Console Recipient is already placed. It is possible to use this recipient (re-
name it to proper name) or place a new one. 
 

This Console Recipient is coming form the SaiaPCDSupervisor.ntpl tem-
plate file.

 
The alarm console is one way to inform the User about alarm occurred in the sys-
tem. There can be other way like sending E-mail or SMS.  
 

 

4.	 Wire the Alarm console and the Alarm Classes together as the next image shows. 
The system has to know what to do with the alarms so that the Alarm Classes 
(container of alarms) and the Alarm Console (a way to display them) has to be con-
nected. 
 

5.	 Copy the BooleanChangeOfStateAlarmExt from the Palette / Alarm / Extensions 
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to the data point where alarm has to be added. (Boolean datapoint called: Points/
Heating1/Supply/Pump/Alarm) 
 
In the pop-up Name field give a proper name (or just leave it default)   
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6.	 Set up the properties of the Alarm Extension 
Alarm inhibit = false
Alarm Enable = x toOffnormal ; o toFault
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Property Value Meaning

Alarm inhibit True/false Alarm is activated / deactivated 

Inhibit Time hours / minutes / 
seconds

Stages of the alarms

Alarm state 	- Fault
	- offNormal
	- Normal

	- Fault: value is invalid e.g hardware fault
	- offNormal: value is valid but out of the its 
borders

	- Normal: value is valid and inside of the border.

Time Delay hours / minutes / 
seconds

Delay before alarm is generated

Time Delay To 
Normal

hours / minutes / 
seconds

Delay before alarm state goes away (if the alarm 
in the corresponding device is already cleared) 

Alarm Enable ToOffNormal / To Fault Enables the Alarm stages to be monitored

To Offnormal Times Alarm Timestamp The details of the last occurred offNormal alarm

To Fault Times Alarm Timestamp The details of the last occurred Fault alarm

Time in the Current 
state

hours / minutes / 
seconds

The elapsed time since the state was changed

Source name %parent.display-
Name%

It takes the name from the parent object name. 
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7.	 Set up additional parameters 
 
To Fault Text – Pump fault (it is unchecked, we do not have info if the value is reli-
able or not. If there is communication error between the Saia PCD® Supervisor and 
the PCD device then the state will be different) 
 
To Offnormal Text = Pump Error (this will be the alarm)
To Normal Text = Pump OK (text when the alarm leaves)
Offnormal Algorithm / Alarm value = true
Alarm Class = Critical Alarm class (created earlier)
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Property Value Meaning
To Fault Text Any text which refers to the state User defined / can be seen in the Alarm Console

To Offnormal Text Any text which refers to the state User defined / can be seen in the Alarm Console

To Normal Text Any text which refers to the state User defined / can be seen in the Alarm Console

Hyperlink ORD ORD, BQL Query or path When an alarm is reported in the console, the Hy-
perlink button activates. Clicking this button links to 
the location you specify here.

Sound File Path text Path of the sound file for audible alarm.

Alarm Icon Path text Path of the picture which is displayed in the "times-
tamp" column in the Console Recipient view.

Alarm Instructions Instruction text It is possible to define instructions what tod when 
alarm occurs.

Fault Algorithm Fault Algorithm Algorithm to generate alarm on Reliability of the 
associated point. This property when available, 
displays fault parameters. Different options are 
available here, depending on the alarm extension 
being used. 

Offnormal Algo-
rithm

Boolean Change Of State 
Algorithm

Algorithm of generating the alarm. Inside it is possi-
ble to set parameters to define the way of the alarm 
generation

Alarm Class Any proper Alarm Class Which Alarm Class is used to collect the alarm

Meta Data Text Allows you to enter new facets for the extension. 
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8.	 Open the Alarm console (double click on it). 
It is possible to check the behavior of the Alarming of the  
Points/Heating1/Supply/Pump point. 
 

 
 
When new alarm comes there is an audible sound to indicate it. This feature can 
be deactivated with the Silence button. 
 
The Alarm can be Acknowlwedged, the list is updated accordingly. 
 
It is possible to add notes to the alarm stored in the Saia PCD® Supervisor. 
 
Possible to define filter the Alarms, for example filter only the Alarms which is rele-
vant to the operator sitting front of the screen. 
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6.2.6	 Add History to a data point in the Saia PCD® Supervisor
In the Saia PCD® Supervisor there is a History Service which can be used to set history 
log for individual datapoints.

For example the values of the Outside Air Temperature can be logged (history) then 
later the logged values can be displayed as trend curve or just a plain text table with 
the values in time order. It is also possible to export the values (in a defined time span) 
to external file. 

There is an other way of logging the history, which is described in details later in this 
manual. The histories (called HD Logs) are generated in the PCD Device and the 
Saia PCD® Supervisor appends the content to history files located in the Saia PCD® 
Supervisor. 

6.2.6.1	 Steps to setup History for a datapoint in the Saia PCD® Supervisor
1.	 Check the History Service in the Services folder of the Station  
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2.	 Open the history Palette and copy the NumericInterval extension to the datapoint 
called Points/Heating1/Outside/Temperature/PhysVal. 
 
In the pop-up window it is possible to rename the extension to a suitable name. 
 
It is also possible to choose other type of history, for example Numeric COV or 
Boolean Interval etc. Please check the different type of History Extensions in the 
Niagara documentation. 
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3.	 setup the parameters of the NumericInterval extension. 
 
Enabled = True
History name = %parent.parent.parent.name%_%parent.parent.name%_ 

   %parent.name% 
Interval = 1 min

 

  
 
Property Value Meaning
Status Enabled/Disabled Show if the history is enable or not. It is always dis-

abled after configuration. The user has to enable it. 
Fault Cause Any kind of system 

generated fault
Error occurred during History creation. For example 
the name of the history is too long (more than 67 
chars)

Enabled true / false Switch to Enable / Disable the history of that point
Active period Days of Week /  

Time range
Possible to schedule when the historization of that 
datapoint should be switched on

History name Defined name of 
the history 

It is possible to give name to the history or generate 
the name from the datatpoint name. 
For example: 
%parent.parent.parent.name%_%parent.parent.
name%_%parent.name% 
will generate the following name 
Outside_Temperature_PhysVal

History Config .. Summarized set-
tings of the History

It is possible to navigate one step down and modify the 
settings in detail.

.. ID ID of the History Generated by the system, should be unique.

.. Source Source of the  
History

The full ORD of the history.
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.. Time Zone Time zone The configured time zone of the PC where the 
Saia PCD® Supervisor is running 

.. Record type Record type It is preconfigured in the Palette / Extensions

.. Capacity Record count / 
Unlimited

The number of the records allowed to create / unlim-
ited. It depends where the History is created. Limit-
ed size of memory device can be used to store the 
History. 

.. Fill policy Roll/Stop Roll – the oldest history will be overwritten with the 
newest log  
Stop – when the record count is reached the logging is 
stopped

.. Interval Interval of the 
logging

It is possible to setup the interval between two logs 
creation.

.. System Tags e.g.: NorthAmerica; 
Region1; Cities.

This property allows you to assign additional metadata 
(the System Tag) to a history extension.

.. minRolloverValue number It takes over the settings from the same property 
below.

.. maxRolloverValue number It takes over the settings from the same property 
below.

.. precision 32 bit / 64 bit It takes over the settings from the same property 
below.

.. valueFacets e.g.: units, pre-
cision, min, and 
max.

Facets contain additional data applied to input and 
output values.

Last Record Date and time The date and time of the last value is stored.
Interval Interval of the 

logging 
Same as above: It is possible to setup the interval 
between two logs creation.

Precision 32 bit / 64 bit The same as above: Precision of the floating point 
value which is used for that history.

Min Rollover Value number Related parameter for "Delta" logging for e.g. electric 
consumption for displaying the difference not the abso-
lute value.  It is valid for NumericChangeOf Value and 
for Numeric Interval. See Niagara documentation. 

Max Rollover Value number Related parameter for "Delta" logging for e.g. electric 
consumption for displaying the difference not the abso-
lute value.  It is valid for NumericChangeOf Value and 
for Numeric Interval. See Niagara documentation.

 

4.	 Save the settings
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5.	 The following History is created 
 

  

6.	 Double click to the name of the History  
 
The Chart of the logged values will be opened. 
 
Additional features can be checked in the Niagara documentation. 
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6.3	 Using the “Saia PG5 Data Import Wizard”
The import wizard an offline add-on tool to import the symbols from one or more Saia 
PCD® device(s) to the Saia PCD® Supervisor point database. The Import Wizard is in-
tegrated into the Saia PCD® Supervisor (it is not a standalone tool). The Import Wizard 
gives the possibility to import the “symbols” from one or more SBC PG5 project, which 
can content of course many PCD devices per each. 

The symbols, to be imported, can be filtered by type, by name. 

The symbols can be re-imported any time or after modification has been done in the 
PG5 project. User can decide if the imported symbols are overwriting the points in the 
Saia PCD® Supervisor, or not. 

The import procedure can be cancelled and new-started any time. 

During import an error check is done, which ensures that only the good formed sym-
bols are imported. The absolute necessity of using unique point names are ensured 
through the PG5 symbol table. The PG5 project can be buildable if the symbol table is 
correct. The downloaded PG5 program and the Saia PCD® Supervisor imported points-
must be all the time consistent.

When symbols from multi project are imported the System Integrator must make him-
self sure, that there no the very same named symbols (points) are getting imported. 
For example there are two PG5 project created, one is called Building_A and the other  
Building_B. Inside of both projects there are PCD devices called CPU1, CPU2, CPU3. 
This happens because the Building_B project is just a copy of Building_A project. Let 
us assume that the Building_A project has been already done. During import of the 
Building_B project e.g. the CPU1 symbols from Building_A are getting overwritten while 
the symbol name structure are the same in both projects. To avoid such a situation it is 
recommended to have a unique ID for each PCD device in the projects to be imported. 
Or use dedicated “Saia Burgess Controls Driver“ for each PG5 project. 

The points in the Saia PCD® Supervisor point database are structured hierarchically ac-
cording to the symbol groups in the symbol table of PG5 project. 

The following different type of symbols and other information/data can be imported from 
a PG5 project to the Saia PCD® Supervisor point database.

1.	 PG5 symbols or datapoints 

2.	 Alarm list generated in the PG5 project 

3.	 Historically logged data so called HD Logs.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based 
alarms are not supported. Before importing the Alarm list and the HD Logs the web 
project in the Web-Editor 8 must be compiled. Take care to select the language for the 
Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv 
files) must be available for import.  
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The 'Saia PG5 Data Import Wizard' is not supported on the Honeywell Optimiser  
Advanced Controller.

6.3.1	 Important information about import wizard process  
in Saia PCD® Supervisor 2.1
Prior to version 2.1, projects were imported in Saia PCD® Supervisor by using CPU 
device name as slot in the ORD path from the PG5 project. This could cause an issue 
when importing device with the same CPU device name from different PG5 project into 
the same SBC supervisor station where unique name are required.

With the current newer version Saia PCD® Supervisor 2.1 the PG5 import wizard pro-
cess apply a rule to compare the CPU device name and IP-Address as configured in 
PG5 device configuration. During the import process the device will be now mapped 
within the SbcIpNetwork applying a unique name conversion through SbcHeadstation 
or SbcSupstation appending to that a suffix number.

In case customers require to still use the old naming convention, we recommend 
performing that via Rename feature. The system as it is designed now will resolve the 
unique address by suing, as explained above, the combined reference of IP address 
and device name, independently from the name.

For further detailed information please refer to the Saia PCD® Supervisor manual or 
contact SBC technical support to get additional support.
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6.3.2	 Preparation
For importing the Symbols from PG5 project we need to use the Saia PG5 Data Import 
Wizard tool.

The “Saia PG5 Data Import Wizard” is installed together with Saia PCD® Supervisor.

It is a fact that the PG5 project (the program of the PCD controller) – from where the 
symbols, to be imported - is developed in a completely different tool, and this tool is not 
integrated presently in any way into the Saia PCD® Supervisor. Due to this fact at the 
beginning the Saia PCD® Supervisor has no information about the PG5 project and its 
symbols.
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It is needed to copy the actual up to date and compiled PG5 project under to the Sta-
tion where it will be used. 
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Typical shared folder of a station would be like this:

	 C:\ProgramData\Niagara4.7\SBC\stations\Demo_Station\shared

So the complete PG5 project has to be copied there.

The copy procedure has to be repeated at each time when modification was made. 
(When compile of the PG5 project was happened, so the content of the symbol table 
could have been changed).

Naturally when the symbol table is changed, it is necessary to re-import the symbols 
from the PG5 project to the Saia PCD® Supervisor point database.

During new import the Saia PG5 Data Import Wizard will retain all user defined con-
figuration of a datapoint, except memory address and comment. User can choose to 
overwrite comment or address&comment during the process.
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6.3.3	 Importing symbols from PG5 projects
For importing symbols from the PG5 project the “Saia PG5 Data Import Wizard” has to 
be started. This tool will do an offline symbol import. When the symbols are imported to 
Saia PCD® Supervisor then we can call them "Points". Discovery of the symbols in the 
Saia PCD device and do online symbol import is not possible.

1. Double click to the Saia PG5 Data Import Wizard under the currently used Sta-
tion. The Wizard opens.

At the beginning nothing is selected.

2. Chose the right PG5 project. Click to the “File” button and select the PG5 pro-
ject file of the project copied to the shared folder of the Station. Press OK.
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3. Check the datapoints and press Scan

At this window press Proceed

It is possible but please try to avoid accented or special characters.

Not supported characters $,# and %. 

For others proper code page has to be selected then they are cor-
rectly visible.

4. The amount of the possible symbols are calculated. Press Next.
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5. The symbol list is populated. 

The top of the Wizard window can be seen that the procedure is at the stage of 
datapoints. 

The left side of the Wizard window the found Devices with the symbol groups 
of the selected device. There is also a filter icon which pops up the possible 
filter settings. 
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In the middle of the Wizard window the symbols are shown with full names and 
details. It is possible to zoom the window by clicking the icon at the right top-
most corner.

The symbols can be selected one by one by checking the checkbox beside the 
symbol. Or at the top beside the Point Name by checking the checkbox all the 
symbols are getting selected in the actual group. 
 
The Data Format can be changed per Points. For example, when Register is 
the data type from the PG5 project the format of the data in the register can be 
Signed / Unsigned Integer or Motorola / IEEE float. 

6. The right side of the Wizard window shows those symbols which are selected 
therefore are getting imported. This window can also be zoomed. Beside the 
symbol the big X icon is used to remove the symbol from the selection.
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7. Because in the middle window of the wizard shows all the symbols the System 
integrator has to be able to select the symbols which are needed to be import-
ed. Filter can be defined, so only the interesting symbols will be shown.

It is possible to select the type of the symbols to be filtered.

Or it is possible to define symbol groups not to be displayed. For that user must 
click to the + icon at the right side of the list and define the Group name (e.g. 
Web). There are some default symbol groups predefined.

Click to Apply to make the filter settings effective.

Or you can Restore Defaults settings when it is needed.

8. We need the symbols from the Heating1 group and also from the Web group. 
Select them and press the Next.
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9. Pop-up window is displayed to warn you to overwrite or not the datapoint (the 
first one in the list). 

It is possible to select the action for the remaining conflicts of the point data-
base.

Check the “Do this for all conflicts” and press Overwrite.

Presently it works this way
	- Overwrite = it overwrites the addresses and also the comments

	- Skip = it overwrites the addresses only

During new import the Saia PG5 Data Import Wizard will retain all 
user defined configuration of a datapoint, except memory address and 
comment.
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10. The SBCIpNetwork driver folder is automatically generated under the Drivers 
folder of the Station. The datapoints were imported to the Points folder of the 
SBCIpNetwork driver. The datapoints are hierarchically structured as they are 
in the PG5 symbol table. The main folder of the Points are named according to 
the Device name in the PG5 project. 

PCD device name can be the same in different PG5 Projects. Take 
care of it and make it sure that the imported Device names are unique 
in the Saia PCD®Supervisor.
The Import Wizard always put the points in the SBCIpNetwork folder. 
This folder can be renamed. The next import then will be done to the 
renamed folder. The target folder of the import can not be freely cho-
sen. 
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11. It can happen that the generated structure is not fitting to the predefined struc-
ture of the Saia PCD® Supervisor. 

Then it is possible to move the points to an other “SBCIpNetwork” with simple 
cut and paste action.  

          
The not used “SBCIpNetwork” then can be deleted. 

It is also possible to rename the element of the folder structure. It makes 
mainly sense to rename the PCD Device (the top folder). The folders under are 
having the right names since the PG5 project is also built up with structured 
symbol names. Let us rename it to “Device1” 

Presently the Saia PG5 Data Import Wizard is not capable to follow up 
the Folder structure changes. So at the next import it will again import 
the symbols under the SBCIpNetwork under Drivers.
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12. During the import a Conversion with factor 0.1 is applied automatically to 
every Registers which has data type Signed or Unsigned Integer. This con-
version is used because the numbers in the Registers of the PCD device are 
usually multiplied with 10. This multiplication is a kind of standard conven-
tion in case of Building Automation Projects. Of course the conversion can be 
removed or modified by hand. For example, we need to modify the conversion 
when we are working with time values. Then the division between minutes and 
seconds would be 60.

During new import the Saia PG5 Data Import Wizard will retain all user defined con-
figuration of a datapoint, except memory address and comment. User can choose to 
overwrite comment or skip during the process.
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6.3.3.1	 Properties of an imported datapoint
It can be seen in the AX Property Sheet of the datapoint that, there are many properties 
available.

We already touched the “Conversion”.

In this chapter the others will shortly be described. 

Let us double click to symbol which is “Numeric Variable” type. 

For example:Device1/Points/Heating1/.Outside/Temperature/PhysVal. 

The AX property Sheet will come up because this is the associated page (default by the 
system, but changeable) to the datapoints.
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Short description of the properties (top to down, row by row):

1. Name of 
the data-
point

without group structure and the type in bracket. The type of the 
datapoint is determined by the Saia PG5 Data Import Wizard dur-
ing import. (changeable)

2. Facets This property allows you to configure how the value of the compo-
nent is displayed. For example, on a Numeric Writable component 
you can set the units, precision, minimum and maximum value for 
the Out property value.

In case of the example we can use the following settings. We use 
three decimal precision. The “-inf and +inf” are the +/- infinity. As 
it is a measurement which comes from the PCD controller we do 
not need to set min and max. But for a writable parameter for a 
setpoint or for an output it makes sense to define the min / max 
parameter in order to ensure the operator typed value never goes 
out of its borders (e.g. by misstyping). The engineering unit can 
also be selected. 

Unfortunately the Facets settings are not set automati-
cally for the imported points. This means that the Facets 
parameters must be set for every each imported points 
manually.
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3. ProxyExt We use in the Saia PCD® Supervisor so called Proxy Points (this is 
a feature of the Niagara framework). The function of the Proxy Point 
is to show the values of the symbols from different controllers in a 
uniformed way. The Proxy Points then are behaving in the same 
way inside of the Saia PCD® Supervisor regardless if they come 
from a Saia PCD controller or from a third party device.

1. Status {ok}	 communicating and ok 
{fault}	 communicating but the value is  
	 not correct 
{down}	 no communication 
{disabled}	 point is disabled  
{stale}	 the value of the point is not  
	 trustworthy

2. Fault cause Possible cause of the fault

3. Enabled Enable / Disable the communication of this 
datapoint (Save it if modified)

4. Device  
Facets

In cases for drivers that support a “Dis-
covery” mechanism, a proxy point may be 
created with its facets (units) already de-
fined—these reflect its “Device Facets” (in 
its ProxyExt). Not applicable for Saia PCD 
Devices due to no discovery.

5. Conversion (Type, Scale and Offset): the raw value 
comes from the PCD controller can be con-
verted using different mathematical transfor-
mation.

6. Tuning 
Policy

If other tuning policy has been defined it can 
be selected here. The Tuning Policy is used 
to define how frequently the datapoint is 
communicated.

7. Read Value Value from the controller as it is.

8. Write Value The type of the datapoint is Numeric Writ-
able. So it possible to write back value to 
the PCD Controller. Because the connected 
variable in the PCD controller is a freely 
readable and writable Register. Other hand 
it can happen the user program in the PCD 
controller s just cyclically overwriting this 
Register.

9. Memory  
Address

The address of the memory slot in the PCD 
controller to communicate with.

10. Data Format How the value is represented in the memory 
slot in the PCD controller.
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4. Out This is the value which can be visible in the Saia PCD® Supervisor 
and be used/connected to other place (e.g. creating logic in the 
Wire Sheet”

5. In1 to In16 These are inputs of this Proxy Point, if we see it as a Function 
box. The inputs can be connected to somewhere to get values or 
it is possible to define the value directly. There is a defined prior-
ity between the inputs (lowest In16). The values of the inputs can 
be enabled / disabled with checking the checkbox “null”. Then the 
values which is the highest priority will be downloaded to the PCD 
controller.

6. Fallback When any of the Input are not applied the Fallback value is ap-
plied.

7. Override  
Expiration

It is possible to command Permanent or Time-duration bound 
override. When Time bound override is applied, then the Override 
Expiration shows the time and date when the override goes back 
to Auto automatically. 

8. Media Type The type of the memory slot in the PCD controller. Needed for the 
correct communication.

9. Comments Imported comment from the PG5 project.

10. Icon Internal picture associated to this type of variable.

Certainly the other type of datapoints have a bit different looking Property Sheets. I do 
not describe every each of them. To get familiar with them needs self-study and read-
ing the manuals.
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6.3.4	 Alarming
Importing Alarm list generated in the PG5 project
There are at least two possible ways to handle the Alarms in the Saia PCD® Supervisor.

1.	 The Alarms are generated in the PCD controller. They are organized to a memory 
territory, with Alarm text, time stamp, status (Acknowledged, Deleted, New, etc.) 
and comment. This information can be then imported to Saia PCD® Supervisor. 
 

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC 
Suite based alarms are not supported. Before importing the Alarm list and 
the HD Logs the web project in the Web-Editor 8 must be compiled. Take 
care to select the language for the Alarm list before compile in the Web-
Editor 8. The up to date configuration files (csv files) must be available for 
import. 

2.	 In the Saia PCD® Supervisor there is alarm service which can be used to set 
Alarms for individual datapoints, regardless if the datapoint is considered alarm or 
not at the start of the engineering. For example the Outside air temperature can 
generate an alarm when it is crossing the -20°C. For that we need to set monitoring 
of this temperature in the Saia PCD® Supervisor. So the Alarm is generated in the 
Saia PCD® Supervisor not in the PCD controller. Therefore this alarm can not be 
seen for example in the SWeb application.

Here in this chapter we will see how to import the Alarm list form the PCD controller.

1.	 The Saia PG5 Data Import Wizard must be started. 

2.	 The right PG5 project file must be selected in the File edit field.

3.	 Check the Alarm List checkbox 
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4.	 Press Scan. The Alarm list of the selected PG5 project is being scanned. 
 

5.	 Select the Alarm list to be imported. 
 

6.	 If the Alarm list is generated with more languages then select the required languge. 
 

 

7.	 Press Next. And confirm to overwrite the Alarmlist. 
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8.	 The Import is running  
 

 
 
Import is ready. The details can be checked under the Device/Alarms folder. 
 
More details are not available.  
 

 

9.	 Check the Alarming behaviour by generating test alarms in the corresponding Saia 
PCD controller. 
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6.3.5	 Importing Historically logged data so called HD Logs
There are at least two possible ways to handle the Historically logged data in the 
Saia PCD® Supervisor.

1.	 The HD Logs are generated in the PCD controller. The HD Log data can be saved 
in different format and into different memory territory in the PCD device. The 
Saia PCD® Supervisor supports only "csv" file based log data which are saved to 
the Flash File System of the PCD device. (This means that, the HDLog 3.0 Fbox 
generated logs, which are saved to INTFLASH, M1_2FLASH and SLOT0_3FLASH 
can be imported.)

2.	 In the Saia PCD® Supervisor there is History Service which can be used to log the 
interesting values to the hard drive of the PC. So the logged data then any time can 
be retrieved and can be displayed e.g. as a trend curve. So the Historical Log is 
generated in the Saia PCD® Supervisor not in the PCD controller. 

Here in this chapter we will see how to import the HD Logs form the PCD controller.

1.	 The Saia PG5 Data Import Wizard must be started. 

2.	 The right PG5 project file must be selected in the File edit field.

3.	 Check the HD Logs check box, and press Scan 
 

     

4.	 Press Proceed or select the right codepage manually and press Proceed. 
 

 



6-63

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Using the “Saia PG5 Data Import Wizard”

Creating/Engineering a project

6

5.	 Summary of the found HD Logs is displayed, press Next  
 

 

6.	 The detail view of the HD Logs is displayed. Select the needed HD Log files. Inside 
of one HD log file can be many different data points logged (symbols). Then press 
Next. 
 

 

7.	 Check the check box and press Overwrite to proceed. The existing configuration 
will be overwritten. 
 

 

8.	 The Import Wizard reports the successful import. 
 

 
Import is ready. The details can be checked under the Device/Alarms folder. 
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9.	 Check the result in the NAV tree / Device / Histories. 

10.	 The default settings is to get the data from the PCD device (controller) once per 
day. This can be changed to get the data faster for example every 10 minutes. 
 

6.3.6	 Starting the communication after the import

Drivers can be seen effectively as language packs. After the execution of the 
Saia PG5 Data Import Wizard we have got a new driver called the SBCIpNetwork. 
Once a driver is in place and configured the Saia PCD® Supervisor can speak to that 
protocol.

The PG import wizard works offline. It does not require a network connection to the 
PCD.

If the IP address and S-Bus station number of the Saia PCD® Supervisor was correctly 
configured in the Device configurator and the PCD with the Saia PCD® Supervisor 
software is connected to the same network and if the network setup is correct, then the 
communication should work directly after the execution of the “Import wizard” without 
problems.
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6.3.6.1	 Enabling the Saia PCD S-Bus IP-Driver
1.	 In the Nav tree open the Station/Drivers/SBCIpNetwork. Double click on the  

Device1.

2.	 In the property sheet check the settings (red colour marked lines) and enable the 
driver.

3.	 Save the modification. 
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6.3.6.2	 Checking different settings to get the communication working 
The following picture shows that the communication is not working the devices are 
orange colored

The following steps are needed to do debugging communication problems.

1.	 Check the communication between PG5 and the Device 
This only works if the PG5 is installed onto the same PC 
 
It should be possible to go online to the PCD with the online configurator of PG5 
over a “Socket connection” 
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2.	 If it’s not possible to go online over Socket to the PCD, try to ping the IP-address of 
the PCD. 
 

 
 

If it’s not possible to PING the PCD, there must be a problem with the 
network setup (e.g. IP address or Subnet mask) 

or there is a problem with cabling or switches

or there is problem with Windows Firewall Settings:

- File and Printer sharing must be enabled

- ICMP Echo Requests must be enabled
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3.	 If there is connection to the controller but PCD Supervisor reports communication 
error, check the settings in the network driver. 
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4.	 Restart the Platform Demon at last. 
It is possible that restarting the Platform Daemon will help because the used net-
work adapter and ports settings are getting updated after restart. 
 

 
The communciation is ok when the Devices are not colored and their status is 
{OK}. In addition, it is possible to see valid information of the PCD in the Nav tree 
Device Information subdirectory. 
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6.3.6.3	 Tuning the Saia PCD S-Bus IP-Driver
There are not so many possibilities given to fine tune the communication. It is possi-
ble to set three different kind of speeds (Fast Rate, Normal Rate, Slow Rate) as base. 
Then it is possible to set up the rates for a complete device. 

The polling rate is the same for all datapoints within a Device.

For the Alarm list it is possible to set a polling rate. As default 30 seconds is set. Which 
means, that the alarms located in the Saia PCD device are polled in 30 seconds. Then 
the new alarms and/or acknowledgment are transferred. The polling rate can be ad-
justed or scheduled. The details of the different settings can be found in the Niagara 
documentation.  
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For the Histories (HD Logs) it is also possible to set a polling rate. The default set-
tings is Daily at 2 o'clock in the morning to retrieve the HD logs from the Saia PCD 
Device. This setting can be changed to e.g.: Interval, 30 seconds. Which means, that 
every 30 seconds the HD Log data is polled, then the new values are uploaded to the 
History files of the Saia PCD® Supervisor. The details of the different settings can be 
found in the Niagara documentation.  

Starting with version 2.1 the Alarms Poll Frequency property is not visible below the 
Ax Property Sheet of the SBus Device.

To make it visible and therefore adjustable, switch to the Ax Slot Sheet of the device 
to be adjusted...

...and remove the "Hidden" flag with the function "Edit Flag" at the property:
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6.3.7	 SbcLinear Conversion
6.3.7.1	 Introduction

With the Patch 3127_1 for Supervisor Version 2.1, a new conversion type named  
“SbcLinearConversion” will be introduced. This conversion is only valid for SBC specific 
media types.

6.3.7.1.1	 Before the Patch:
When for example a Register is created below the Points section the point gets the 
conversion type linear set per default:

6.3.7.1.2	 With Patch:
With the Patch all newly generated media gets automatically set the  
SbcLinearConversion as conversion type:
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6.3.7.2 	 Installing the Patch
Download the Patch from SBC Support page and extract the files:

 

Copy all files to the modules folder of your Supervisor Install Path:

After that uninstall/install Plattform Daemon and restart Workbench.

6.3.7.3 	 Import in newly generated stations (after installing the Patch)
After the Patch is installed, all newly generated DataPoints will get add the new SbcLin-
earConversion automatically during import. No special work is needed here:
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6.3.7.4 	 Updating existing stations
This section describes two ways how to update existing Station.

6.3.7.4.1 	 Change conversion type manually
Go to a subsequent folder where you want to change the conversion type and open 
there the SBC Point Manager view by right clicking on the folder:

Activate the list view by clicking on the corresponding item:
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Open the table settings via click on the button in the upper right corner and set the 
Conversion Column to be displayed:

Choose and select the desired data points and click on the Edit button:
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In the upcoming window the changement to the conversion type SbcLinearConversion 
can be done:

After clicking on OK button, the changement will be applied to all selected items:

6.3.7.4.2 	 Change conversion type automatically (PG5 projects without PointDefinition.csv)
To make the changement automatically done you need to reimport your project with 
Saia PG5 Import wizard. 

During import process select Overwrite:
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6.3.7.4.3 	 Change conversion type automatically (PG5 projects with PointDefinition.csv)
If a PointDefinition.csv is part of the PG5 project you need to take care, if the right con-
version type is set for each the data point. 

Example on macro [_DDC_SPINT2270] from DDC Suite 2.7

Before the patch:

The conversion was assigned during import like this:

ProxyExt:Conversion='Linear+Scale=0.01+Offset=0.0'

The result was:

After patch was installed:

The conversion must be set like this:

ProxyExt:Conversion='SbcLinear+Scale=0.01+Offset=0.0'

After import:
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6.3.8	 Enhanced PG5 Import Wizard
	■ The datapoint filter can now also be applied to tags

	■ Alarms can be configured with the alarm class specified in the AlarmService

	■ All data points are displayed in the list

	■ When importing very large projects, the data points no longer go to the status 
"stale"

	■ Imported alarms now have the correct timestamp 

	■ Array import working 
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6.3.9	 Addition to the standard import 

Starting with Saia PCD® Supervisor V2.1

In addition to the standard import, the extended import wizard from version 2.1 and 
higher allows to add properties like facets, conversions, alarm, history extensions and 
more to the points during the import process.

6.3.9.1	 The additional properties are required to work with  
the easy templating library DDC27

	■ To support the new import features PG5 2.3.175 and higher is required as well as 
the start of projects is recommended to use the new multilingual DDC-Suite 2.7 
starting project ending with ML. 

	■ In additional project not based on the new start project can get extend by the 
necessary additional information’s using a helper application which allow to 
generate the list of used macro names in the project. 

6.3.9.2	 The predefined graphical templates for DDC 2.7 are created  
to support the DDC Suite 2.7 environment

	■ The easy Templating process itself can support various constellations of templates.

Important to know:
	- Since Saia PCD® Supervisor 2.1 the CPU name from PG5 is no longer the import location in 

the NAV tree. 
	- The import location is now based on the IP-Address of the device and the CPU name is given 

from PG5 on top as the display name.
	- During import the engineering point names are translated from different languages to English. 
	- This makes it possible to use one set of templates for all different existing languages for DDC 

Suite 2.7 projects. 
	- On top of the engineering data point name a display name will be added which represents the 

imported language in the NAV tree so the engineering and display name can differ.
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6.3.10	 System consequences for duplicated CPU names
Starting with V2.1! 

During Import the IP-Address of the imported devices configured in the PG5 device 
configuration is used to identify the station below the S-Bus IP driver Network.

During import a unique naming convention is created for the device ORDs like 
SbcHeadStationX(x=INT) or SbcSubStationX(x=INT). The display name of the ORD 
from the imported note is set to the device name from the PG5 project.

This allows to import from different PG5 Projects having same device names applied 
without changes to the project.

If a station with the same IP-Address is imported and already existing below the S-Bus 
driver network, you will get asked to enter prefix before the import. 
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6.4	 General functions
6.4.1	 Configure Scheduled tasks

This chapter describes how to configure Schedulers to control the automations system 
during occupied and non-occupied time.

Scheduler
The Scheduler provides control of values and changes setpoints based on time and 
date. Lights, Fans, and HVAC equipment are turned on and off based on the time, day 
of week and date. The Scheduler is also used in process control and manufacturing 
applications. 

Presently there is no Saia PCD® Supervisor compatible Schedulers in the Saia PCD 
Device. It means that, if the automation system needs high level scheduling functions, 
this must be done “upstairs” in the Saia PCD® Supervisor not in "downstairs" in the 
PCD Device. Which has the drawback that if the Supervisory computer fails to work 
the Scheduling function fails too.

There is an exception. It is possible to use the Saia PCD Device as BACnet Control-
ler, in this way the BACnet standard scheduling functions can be used. This is com-
patible with the Saia PCD® Supervisor. However it needs to license and use the 3rd 
party (BACnet) driver in the Saia PCD® Supervisor.  

Schedules are created using schedule components found in the schedule palette. 
Place these components in a station, configure, and link as needed to provide schedul-
ing control of other components.

Scheduling functionality is the same whether using Workbench or an HTML5 web 
browser with one exception. Currently, in a web browser connection, you do not have 
the options to copy or paste components.
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Schedule component categories

Component category Description

Weekly Boolean 
Numeric 
Enumerated 
String

Weekly schedules define regular, repeating, events 
by “time-of-day” and “day-of-week.” Also, you can 
configure any number of “special events” on a weekly 
schedule. Weekly schedules are the most used sched-
ule components. Four different types vary by data 
category (Boolean, Numeric, Enum, and String). Each 
is identical except for input/output.

Calendar Calendar schedules define specific days. Use a cal-
endar schedule to define days with scheduling excep-
tions (e.g. holidays), and reference them in the “spe-
cial events” setup of weekly schedules.

Trigger Trigger schedules fire actions or topics. With a set 
of pre-configured schedules and a ScheduleSelec-
tor component, you can simply choose from a list of 
valid schedules to setup or change the schedule of a 
device.

Selectors Schedule Selector components provide an easy way 
for you to select a schedule to use for controlling a 
particular component. As needed, you typically link its 
output to an action of a control point or extension.
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Schedule component views

Weekly Default view for any weekly schedule component. In Work-
bench the Scheduler view provides four configura-
tion tabs:

Weekly Schedule Sunday-through-Saturday (weekly) event times/
values. Use this to define the regular weekly 
events.

Special Events All exceptions to the defined weekly schedule, as 
special events. Use this to define special event 
times.

Properties Important properties such as default output, 
schedule effective times, special event clean-up 
operation, and schedule facets.

Summary for any selected day, provides a tabular summary 
of all schedule events, with source. Also available 
under the Scheduler view dropdown list:

Current Day  
Summary

provides a simple 24-hour linear graph of schedule 
event times and values for the current day.

Calendar Default view for a CalendarSchedule component. The Calendar 
Scheduler view provides a calendar where you 
can add, edit, or delete specific calendar days 
(exceptions to the regular weekly schedule) and 
establish relative priorities.

Trigger Default view for a TriggerSchedule component. The Trigger 
Scheduler view provides a two-part view combin-
ing a “day picker” and an event “time picker” for 
specifying when topics are fired on those days.

We configure a Weekly schedule and a Calendar Schedule in this chapter.

In a web browser the Scheduler view provides two configuration tabs: Weekly Sched-
ule and Special Events. 
While the Current Day Summary and Property Sheet views are available under Sched-
uler view dropdown list.
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Examples
	● Weekly Schedule  

The task is to configure a weekly schedule which switches on the Light in the nor-
mal office time from Monday till Friday and from 8:00 till 17:00. Friday the office time 
is reduced only from 8:00 till 14:00. 
 
There is special event on 1st of September 2017. In this day the Light must be 
switched off from 9:00 till 11:35 due to test.

	● Calendar Schedule 
There are known official Holidays like Christmas or the Swiss National Day where 
the office is unoccupied therefore the Light must be Switched off.

The steps to add and configure Schedulers to the Saia PCD® Supervisor:
1.	 Creating folder for the scheduling components

2.	 Add Weekly Scheduler component from Palette

3.	 Configuring normal events weekly schedules

4.	 Configuring special events weekly schedules

5.	 Add Calendar Scheduler component from the Palette

6.	 Configuring Calendar Schedule

7.	 Make the logic to control the physical point in the PCD device  
or

8.	 Make the logic to control the physical point in the PCD device using reference be-
tween the schedulers.
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6.4.2	 Creating folder for the scheduling components
Schedules can be created and added to any part of Saia PCD® supervisor. However, it 
makes sense to manage these in a central location.

1.	 In the Nav tree open 127.0.0.1(localhost) > Station > Config 

2.	 Create there a folder called Scheduler.

3.	 Double click to the folder. The associated Wire Sheet will be opened. 
 

More details of using Wire Sheet can be found inside of the Niagara docu-
mentation.
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6.4.3	 Add Weekly Scheduler component from Palette
1.	 Open the schedule palette 

 

2.	 Drag and Drop the BooleanSchedule component to the Wire Sheet of the Schedul-
ers folder.

3.	 In the pop-up dialog specify the name of the component (Weekly_Schedule_Light) 
 

4.	 A Weekly Schedule component is placed to the Wire Sheet. 
 



6-87

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

General functions

Creating/Engineering a project

6

6.4.4	 Configuring normal events weekly schedules
1.	 Double click to the Weekly_Schedule_Light function box to open the Scheduler 

configuration window.  
Saia PCD® supervisor Schedules operate Sunday to Saturday and times 
are set from top to bottom.

2.	 In the weekly view specify the time range for Monday. For that go to Monday 8:00 
press the mouse left button and drag the mouse down till 17:00 o´clock.  
The defined time range will be shown as green stripe. 
 

3.	 Do not worry if you do not find the exact time. Below the graphical representation, 
in the Event Starts and Event Finishes edit fields it is possible to type it. 
 
In the headings of the green stripe and in the Event Output drop down box the 
scheduled value can be seen (true). It is possible to invert it.   

4.	 Define time schedule for Tuesday to Friday too in the same way. Take care the of-
fice time in Friday is until 14:00. 
It is possible to do copy and paste. Right mouse click to the green stripe and select 
copy day. The selected time span is then shown in blue colour. Right mouse click 
to the remaining days and select paste day. Then set Friday 14:00 o´clock.
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5.	 Click Save at the bottom of the page. 
 

6.4.5	 Configuring special events weekly schedules
1.	 Click to Special Events at the bottom of the page.

2.	 The Special Events summary page opens with the Today schedule visible. 
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3.	 Click to Add and specify the date 1st of September 2017. 
 

4.	 Click OK

5.	 Specify the schedule to switch off the Light from 9:00 till 11:35. Do this at the right 
side of the window by using the mouse and typing the values by hand. 
Do not forget to specify the “false” value to switch off the light 
 

6.	 Save the configuration
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7.	 Check the summary. Click to Summary at the Bottom of the page. Navigate to 1st 
of September 2017. Then in the text summary it can be seen the Special Event 
entry. 
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6.4.6	 Add Calendar Scheduler component from the Palette
1.	 Open the schedule palette

2.	 Drag and Drop the CalendarSchedule component to the Wire Sheet of the Sched-
ulers folder.

3.	 In the pop-up dialog specify the name of the component (Calendar_Schedule_
Light)

4.	 A Calendar Schedule function box is placed to the Wire Sheet. 
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6.4.7	 Configuring Calendar Schedule
1.	 Double click to the Calendar_Schedule_Light function box to open the Scheduler 

configuration window. 

2.	 Click Add to schedule the Christmas holiday from 25th of December till 31th of 
December. 
 

3.	 Click OK and then click Save.

4.	 Then it makes sense to define a holiday for 1st of January.
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5.	 Then specify the holiday for the 1st of August (Swiss National Day) 
 

6.	 Click OK, Click Save, Click Refresh.

7.	 Check the settings. Green background of the dates means schedule is set. 
 

Short summary is in the middle of the page
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6.4.8	 Make the logic to control the physical point in the PCD device
The previous steps are describing how to add and configure the needed schedulers. 
It is needed to transfer the Schedulers combined Out value to the data point which 
is really communicated to the PCD Device. This point is called Enable_Light in the 
Saia PCD® Supervisor. In the PCD Device the application program monitors this Flag 
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is 
nobody in the building. During the specified time the Calendar Schedule output will be 
high. We need to negate the output of the Calendar Schedule to get the correct logic.

1.	 Navigate in the Nav tree to the Scheduler folder.

2.	 Double click to the Scheduler folder. The Wire Sheet pops up.

3.	 Open the kitControl Palette.

4.	 Drag and drop the “And” and “Not” function block form the Logic folder to the Wire 
Sheet.

5.	 Connect the function block together as the picture shows. 
 

 
 
The Out pin of the And Function box must be connected to the Enable_Light pin 
IN16. But these Function Boxes are located in two different Wire Sheets. 
We need to link these two pins together.

6.	 Open the Wire Sheet for the Scheduler folder (if it is not open). And select the And-
Function Box.
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7.	 Right mouse click to the Out pin of the And Function box, then select the Link 
Mark command from the context menu.  
 

8.	 Navigate to the Points folder of the Device where the Enable_Light point is located. 

9.	 Right mouse click to the Points folder and select the Wire Sheet form the views 
menu.

10.	 Organize the Function Boxes on the sheet to get some spaces between them.  
 
At first time you open this Wire Sheet the Function Boxes which are represent-
ing the Points in that folder are overlapping each other.  The Function Boxes are 
configured that way that the Out, In10, In16 pins are visible. Right now these pins 
are enough for our work. But keep in mind that, the visibility of the pins are config-
urable, so many other pins can be set to be displayed. 
 
The meaning of the pins can be checked deeply in the Niagara manual.

11.	 Right mouse click to the In16 pin of the Enable_Light Function Box.



6-96

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

General functions

Creating/Engineering a project

6

12.	 Select the Link from “And” command form the context menu. 
 

13.	 In the pop-up window the link between the two Function Boxes must be defined as 
the picture shows. The link can be checked by reading the text at the bottom left 
corner of the window. 
 

14.	 Click OK. The pop-up will be closed

15.	 In the Wire Sheet check the marks of the link and also check that the link is live. It 
means that the Points/Enable_Light function box In16 pin follows the Schedulers/
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And Function Box Out pin of the And function box. 
 

16.	 The state Out pin of the Enable_Light function box normally follows the state In16 
pin. The Out pin shows directly which value is downloaded the PCD device.

17.	 If the state of the Out pin has different value then the In16 pin the following can 
happen. 
 
A. The Out pin is forced by operator  -> set back to Auto 

 

B. 	- Other higher level of InX pin is getting value from somewhere. 
	- Check the logic if it is valid 
 



6-98

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

General functions

Creating/Engineering a project

6

C. 	- Inside of the Function Box other InX pin is selected with value to override 
the output.

	- To check it double click to the Function Box.  
The prioritized override technique of the Out pin is described in the Niagara 
manual.

	- The picture shows that, In2 overrides In10 and In16 to command the Out 
pin. 
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6.4.9	 Make the logic to control the physical point in the PCD device 
using reference between the schedulers.
The previous steps are describing how to add and configure the needed schedulers. 
It is needed to transfer the Schedulers combined Out value to the data point which 
is really communicated to the PCD Device. This point is called Enable_Light in the 
Saia PCD® Supervisor. In the PCD Device the application program monitors this Flag 
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is 
nobody in the building. During the specified time the Calendar Schedule output will be 
high. We need to negate the output of the Calendar Schedule to get the correct logic.

There is another more elegant way to make the connection between the Calendar 
Scheduler and the Weekly Scheduler. The way is to define reference between them.

The Calendar Scheduler is higher in priority, so we need to make a reference from the 
Weekly Scheduler to the Calendar Scheduler. 

1.	 Navigate in the Nav tree to the Scheduler folder.

2.	 Double click to the Scheduler folder. The Wire Sheet pops up.

3.	 Double click to the Weekly_Schedule_Light. This will open the configuration win-
dow of the Scheduler.

4.	 Click to Special Events at the bottom of the page

5.	 Click to Add

6.	 In the pop-up window go to the Type and select Reference then click to OK. 
 

7.	 In the next pop-up window it is possible to select to which Scheduler the reference 
must be added. Here there is only one scheduler listed. Select Calendar_Sched-
ule_Light then click OK. 
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8.	 The Event = Reference to the weekly scheduler is added. But it is “Unscheduled”, 
can be seen in the right side.  
 

9.	 We need to define that during the Holidays, when the Calendar_Schedule_Light 
is high the Weekly_Schedule_Light must be low. For that the complete time range 
has to be defined to false. 
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10.	 Save the settings

11.	 Test the configuration by adding the today to the Calendar_Schedule_Light. This 
means create today as Holiday day. 

12.	 Check that the Weekly_Schedule_Light Out pin goes low.

13.	 Remove the test setting from the Calandar_Schedule_Light.

14.	 Create reference between the Weekly_Schedule_Light Out pin and the Enable_
Light In16 pin in the same way as it was described above. 
As you see the Not and the And Function Boxes are not needed to realize the 
same function. 
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6.5	 Connect to 3rd Party Systems
If you have purchased an OPEN license and want to use values from non-Saia Bur-
gess Controls systems it is necessary to connect to the 3rd-party systems and add the 
required points to the Saia PCD® Supervisor database.

6.5.1	 Add the Required 3rd Party Drivers
1.	 In the Nav tree open the Station folder.

2.	 Open the Config folder.

3.	 Double click on Drivers. The view pane will show a list of installed Drivers (Driver 
Manager).

4.	 Click on the New button. The New dialogue box is displayed. 
 

 
 
In the Type to Add box select the required driver, e.g. ‘BacnetNetwork’.

5.	 Click OK. The following dialogue box is displayed. 
 

 
 
Change the default network Name to be a meaningful name. 

6.	 Click OK. The Driver Manager will now show the driver. 
 

7.	 You now need to configure the driver
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6.5.2	 Configure 3rd Party Drivers
The configuration of each 3rd party driver is different, refer to the Tridium Niagara docu-
mentation for the details of the driver.

6.5.3	 Add 3rd Party Points to the Database
The method of adding points to the database for each 3rd party driver is different, refer 
to the Tridium Niagara documentation for the details of the driver.

6.5.4	 Using the BACnet Driver
The ability to use values from a BACnet system is quite common and is supported by 
Saia PCD® Supervisor. This section provides an overview of how to use the BACnet 
driver with Saia PCD® Supervisor. For full details refer to the Tridium Niagara documen-
tation.

6.5.4.1	 Configure the BACnet Driver
1.	 In the Nav tree open the Station folder.

2.	 Open the Config folder.

3.	 Double click on Drivers. The view pane will show a list of installed Drivers  
(Driver Manager).

4.	 In the Nav tree open the folder for the already added BACnet driver (BacnetNet-
work) and double click Local Device.

5.	 Set the Object Id to the Saia PCD® Supervisor address on the BACnet network  
(range 1-4194302). 
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6.	 In the Nav tree open the BACnet Comm folder and double click Network and ex-
pand the IP port section also the adapter has to be chosen. 
 

7.	 Set the Network Number to 1. 

8.	 Set Enabled to true.

9.	 Click . 
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6.5.4.2	 Discover and add BACnet Devices
In the Nav tree, open the Drivers folder and double click the BACnet driver. The view 
pane will display the Bacnet Device Manager.

1.	 Click to Discover 
 
The Configure Device Discovery dialogue box is displayed. 
 

 
 
If the address range of controllers is known then the Device Low Limit and Device 
High Limit can be edited to reduce discovery time.

2.	 Click OK.  
The discovery process starts. A progress bar at the top of the pane indicates the 
status of the discovery. Once the discovery is complete the devices that have been 
discovered are displayed in the Discovered list. 
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During the discovery process you can click on the  button at the top 
right corner to display a Job Log giving details about the discovery pro-
cess so far.

 
In the Discovered list select the device(s) from which values are required. To 
select more than one device hold down the CTRL key and click on the required 
devices. 
 

 
 

The discovery will also find SBC Saia Burgess Controls deivces that have 
BACnet compatibility. In order to easily identify these devices sort the list 
by Vendor by clicking on the Vendor column.

Click Add or drag the selected device(s) to the Database list. 
The Add dialogue box is displayed.
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Review the settings for each device:

	● If required, change the device name in the Name box.

	● If multiple devices are listed, click on the device in the list (to highlight it) to view 
its settings.

Check that the required devices have been added.

6.5.4.3	 Add the required BACnet Points to the Database
This process allows you to add points, alarm configuration, schedules and histories 
from previously discovered devices.

1.	 In the Nav tree, open the Drivers folder and double click the BACnet driver. The 
view pane will display the Bacnet Device Manager.

2.	 In the Exts column of the Database list double click the required icon. 
 

= Points
= Alarm Configuration
= Schedules
= Histories

 
The BACnet Point Manager is displayed. 
 

 

3.	 Click Discover
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4.	 The discovery process starts. A progress bar at the top to the pane indicates the 
status of the discovery.  
 
Once the discovery is complete, points are displayed in the Discovered list: 
 

  

5.	 In the Discovered list select the required points (values). To select more than one 
point hold down the CTRL key and click on the required points.

Remember that Saia PCD® Supervisor is licensed for use up to a specific 
number of points. It is good practice, therefore, to only add points that are 
actually required. Adding points that won’t be used by Saia PCD® Super-
visor will not only waste resources but also generate unnecessary extra 
network traffic.

 

6.	 Click to Add or drag the selected point(s) to the Database pane. 
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7.	 The Add dialogue box is displayed.

Saia PCD® Supervisor automatically chooses the most suitable writable 
point type. However, this can be manually changed by selecting a point in 
the list and choosing a different Item Type

8.	 Click to OK

9.	 The selected point(s) is added to the database.  
 

 

10.	 Repeat the above process to add points for each controller.



6-110

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Creating Schematics (Operator Views)

Creating/Engineering a project

6

6.5.4.4	 Enable Honeywell BACnet Service 
The Honeywell BACnet service must be enabled if you want to use the SBC specific 
Add-ons provided by the SBC BACnet Utilities driver. This step must be done before 
creating the BACnet network.

Enabling the service includes 2 steps:

1.	 Adding the service to the Services tree
2.	 Enabling the service on its Properties Sheet 
In SBC NX 4.2.xx.xx.x.x and lower, the service is already added to the Services tree by 
default. In SBC NX 4.3.xx.xx.x.x and higher, the service is not available by default and 
must be added to the Services tree manually.

When using a station from a previous project in SBC NX 4.4.xx.xx.x.x, 
the Honeywell BACnet Service is available in disabled state as shown in 
the Services tree and on the Properties Sheet. If available, the Honeywell 
BACnet Service can be enabled/disabled at any time on the Properties 
Sheet 

6.5.4.4.1	 Procedure to enable Honeywell BACnet Service
1.	 In the Palette tab at the bottom, select honBACnetUtilities from the drop-down 

listbox, then open Services, and then drag&drop the HonBACnetService item to 
the Services folder.  
 

 
 
Result: The Name dialog box displays. 
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2.	 Change the name if desired, and then click OK.  
 
Result: The service is added to the Services folder. 
 

3.	 Double-click the HonBacnetService in the tree. 
 

4.	 On the Property Sheet on the right, select ´true` in the Enabled drop-down listbox. 
 

 

5.	 Click the Save button at the bottom.  
 
Result: The service will be started indicated by ´true` setting in the Running drop-
down listbox. 
 

6.	 Continue by creating the BACnet network.

6.5.4.4.2	 Procedure to change the user access of Hon Data Point View Read Only Users 
for Honeywell BACnet Service
1.	 Double-click the HonBacnetService in the tree.

2.	 On the Property Sheet on the right, expand the Hon Data Point View Read Only 
Users property. 
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Result: The list of all assigned users name list along with default (All, admin, and 
BACnet) user names displays. 

3.	 Select True (to disable access) or False (to enable access) in order to change the 
user access of Hon Data Point View. 
 

 
 
Result: As per the selection, users will see the parameters from Hon Data Point 
View page and their parameters in editable or non-editable view.  
 
Editable 					     Non-Editable 
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6.6	 Creating Schematics (Operator Views)
Schematics within Saia PCD® Supervisor are known as Operator Views  
(Presentation XML -- Px).

This section describes how to create the most commonly required features of Operator 
Views. For more in depth information please refer to the Tridium documentation.

It is recommended that you create a template page that contains features that are 
needed on each page, e.g. a logo, outside temperature, navigation buttons, etc. It is 
also recommended that you create a folder to store all the Operator Views, and another 
folder to store any images used on the pages.

The following steps are required to create Operator Views:

6.6.1	 Prepare the folder structures
Preparing a good folder structure for the used Images and Operator views will help 
keeping the project clear and understable. The engineering work will be faster because 
used elements can be easily found.

6.6.1.1	 Create a Folder for the Operator Views
Operator Views can be created at any point within Saia PCD® Supervisor e.g. added to 
a folder, device or a module. However, this can make engineering unnecessarily com-
plicated so it is recommend that a folder is created to contain them.

1.	 In the Nav tree open localhost > Station.

2.	 Right click Config and select New> Folder. The Name dialogue box is displayed. 
 

 
Specify the folders’s name e.g. ‘Schematics’.

3.	 Click to OK.
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6.6.1.2	 Create a Folder for the Images
1.	 In the Nav tree open 127.0.0.1(localhost)>Station(Demo_Station).

2.	 Right click Files and select New> Folder. The Name dialogue box is displayed. 
 

3.	 Specify the folders’s name e.g. ‘Images’.

4.	 Click to OK.

6.6.1.3	 Prepare Images
Any external images that are to be used on Operator Views must be created using a 
3rd party graphics package and sized to the size required on the Operator Views.

Once the images have been added to Saia PCD® Supervisor they cannot be 
changed. SVG (Scaled Vector Graphics) images can be used and scaled inside in the 
Saia PCD® Supervisor.

6.6.1.4	 Add Images to Saia PCD® Supervisor
To use images within Saia PCD® Supervisor they must exist within the file structure of 
Saia PCD® Supervisor.

1.	 In the Nav tree open My Host > My File System and navigate to the file that is to 
be added (this could be a folder containing multiple graphics).

2.	 Right click the file or folder and select Copy.

3.	 In the Nav tree open My Host > Station(Saia PCD Supervisor) > Files and navi-
gate to the location the image(s) are to be stored 

4.	 Right click the location (e.g. images) and select Paste.
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6.6.1.5	 Customize  the basic PX Template Page
Operator Views are created using the template PX Page (located - My Host > Sys 
Home > defaults > workbench > newfiles > PxFile.px). By editing this page all future 
Operator Views created will have this format.

1.	 In the Nav tree open My Host > My File System > Sys Home > defaults > work-
bench > newfiles.

2.	 Double click the PxFile.px file.

3.	 On the menu bar click the  icon to switch to PX Editor view. 
 

 
 

The grid in the middle of the screen is the viewable area of the page.

4.	 Design the page layout as required.

5.	 Save the file (select File> Save, or press CTRL+S).
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6.6.2	 Create a PX Page

Operator Views are created by making a new view of an element in the Nav tree and 
once a PX view is added it is the new default view of the element.

Operator Views are stored in the Saia PCD® Supervisor file structure, but are linked to 
the element where the view has been attached.
To keep structure simple it is a good idea to create subfolders. These subfolders hold 
the various schematics you want to create.
1.	 In the Nav tree open 127.0.0.1(localhost) > Station > Config and navigate to 

where the PX Page is to be located
2.	 Right click the folder and select New > Folder. The Name dialogue box is dis-

played.
3.	 Specify the page’s name e.g. ‘HeatingCircuit1’. 

4.	 Click OK	 A folder is created.
5.	 Right click the folder you have just created and select Views > New View.  

The New Px View dialogue box is displayed. 
 

 
Enter the name of the page (same as the folder just created) in the View Name 
box.

6.	 Click OK	 The PX Page will be created based on the template page.
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6.6.3	 Edit a PX Page
The PX Editor is used to edit a PX Page.

1.	 In the Nav tree locate the PX file and double click on it.

2.	 On the menu bar click the  icon to switch to PX Editor view.

3.	 Change the page layout as required

4.	 Save the file (select File> Save, or press CTRL+S).

6.6.3.1	 Create or Change PX Page Elements
After creating a new PX Page or opening an existing page for editing use the following 
procedures to design the page layout and content.

6.6.3.2	 Setting the Page Size and Background
To set the viewable area size:
1.	 Double click the layout grid to open the Properties dialogue box.

2.	 Click viewSize to set the visible screen size in pixels (maximum 10000 × 10000).

3.	 Click OK. 

To set the background colour:
1.	 Double click the layout grid to open the Properties dialogue box.

2.	 Click the background as required and select either Solid or Gradient and use the 
colour picker to set the required colour(s).

3.	 Click OK. 

To set the background image:
1.	 Double click the layout grid to open the Properties dialogue box.

2.	 Click the background as required and select Image.

3.	 Select the required image file and alignment settings.

4.	 Click OK.
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6.6.3.3	 Add Text
1.	 Right click the page and select New > Label. A label is added to the page.

2.	 Double click the label. The Properties dialogue box is displayed. 
 

3.	 Enter the required text in the text box.

4.	 Click OK.

6.6.3.4	 Add an Image

Add your own image
Images are sized on the screen based on their native dimensions (pixel size) - you can-
not scale the image. Therefore, you may need to resize the image using your preferred 
graphics editor before adding to the page.

1.	 Navigate to the required image using the Nav tree.

2.	 Click and drag the file to the layout grid and position as required. 
It is recommended that any images you intend using in Saia PCD® Su-
pervisor are first copied into a folder within the Station.

As you drag the item on the page two green lines indicate the top left 
corner where the item will be positioned.
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Add an Saia PCD® Supervisor Image
Saia PCD® Supervisor has some built in images that can be added to a PX Page. 
Open the palette containing the required graphics. The following palettes contains use-
ful images, but there are others available 
 
kitPx Covers elements like – logoff, buttons, PxInclude, line, rectangle 

etc
kitPxHvac is a library of various hardware graphics – pumps, boilers etc
kitPxN4svg is similar to kitPx but all the graphics are SVG  

(scalable vector graphics)

1.	 Navigate to the required image using the palette.

2.	 Click and drag the image to the layout grid and position as required.

6.6.3.5	 Add a Dynamic Object (Value)
1.	 Navigate to the required value using the Nav tree.

2.	 Click and drag the value to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select Bound Label. 
 

 

5.	 Select Format Text and choose %out.value% to display the value.

6.	 Select Make Display Name Label to display the label.

7.	 Click OK.
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6.6.3.6	 Add an Animated Image
Saia PCD® Supervisor has some built in images that can be animated depending on 
value from the system.

1.	 Navigate to the value that is to be linked to the image using the Nav tree.

2.	 Click and drag the value to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select From Palette. 
 

 

5.	 Open the palette containing the required graphics

6.	 Navigate to the required image using the palette.

7.	 Select the required image.

8.	 Click OK.
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6.6.3.7	 Add a Setpoint Slider
A slider can be added to enable an analogue value to be adjusted.

1.	 Navigate to the value that is to be linked to the slider using the Nav tree.

2.	 Click and drag the value to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select From Palette. 
 

 
 

 

5.	 Open the KitPx palette

6.	 Select SetPointSlider.

7.	 Click OK.
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6.6.3.8	 Add a Button to Adjust a Value
1.	 Navigate to the value that is to be adjusted using the Nav tree.

2.	 Click and drag the value to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select Actions. 
 

5.	 Select Set.

6.	 Click OK.
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6.6.3.9	 Add a Link to Another Page
1.	 Navigate to the PX Page that is to be linked to using the Nav tree.

2.	 Click and drag the PX Page to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select From Palette. 
 

5.	 Open the KitPx palette.

6.	 Select HyperlinkButton.

7.	 Select the Hyperlink check box.

8.	 Enter the required text in the text box.

9.	 Click OK.
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6.6.3.10	 Add a Graph
1.	 Navigate to the required history using the Nav tree.

2.	 Click and drag the history to the layout grid and position as required.

3.	 When you release the mouse button the Make Widget dialogue box is displayed.

4.	 Select From Palette. 
 

 

5.	 Open the webChart palette

6.	 Select Chart.

7.	 Click OK.
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6.6.4	 Reuse Operator Views
Operator Views can be reused, saving significant engineering time.

Normally Operator Views are created by using a new view attached to a folder in a 
centralised structure. However, as each PX Page is created in the file system in the ‘px’ 
folder, it is possible  for a page to be reused by copying the file in the px folder and at-
taching it to the required folder.

1.	 Create a PX Page as required - see chapter 6.6.2	 Create a PX Page

2.	 In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Files > px.

3.	 Right click the PX Page that is to be reused and select Copy.

4.	 Right click px and select Paste. The Name dialogue box is displayed. 
 

 
 

 

5.	 Enter a name for the pasted PX Page.

6.	 Click to OK.	 The PX Page will be added.

7.	 In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Config 
and navigate to where the new PX Page is to be located.
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8.	 Right click the folder and select New> Folder. 
The Name dialogue box is displayed. 
 

 
 

 

9.	 Specify the folder’s name e.g. ‘HC2’.

10.	 Click OK	 A folder is created.

11.	 Right click the folder you have just created and select Views > New View.  
The New Px View dialogue box is displayed. 
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12.	 Enter the name of the page created above in the View Name box.

13.	 Click OK	 The File already exists dialogue box is displayed. 
 

14.	 Click Reuse.

15.	 Edit the page as required.
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6.6.5	 Easy Templating Simple Objects
6.6.5.1	 Create simple objects

1.	 Using the standard PxEditor, design a PxPage using graphics, labels or any com-
ponent you would usually use to design the page. Manually bind any points so the 
graphics are a live representation of the object.

2.	 Using the Tools > Easy Templating Simple Object Creator, select the PxPage cre-
ated in step 1, and generate the Simple Object. The new object will appear in the 
Easy Templating Sidebar when created – any errors will be shown in a toast popup.
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6.6.5.2	 Using generated Simple Objects
1.	 On a new PxPage, drag one of the Simple Objects from the Easy Templating Side-

bar onto the page.

2.	 Using either the Properties Sidebar, or the Properties Popup (double click), there 
will be a Easy Templating Binding on the Simple Object with a property reading 
“CLICK_HERE_TO_CHOOSE_BINDING”. Clicking this will bring up matching loca-
tion which meet all the points used in the Simple Object.

3.	 Once a selection has been made, the resources needed for the Simple Object will 
be copied over the from the Simple Object directory, into the running station. The 
variable will then be set, linking the graphic to the chosen location.

4.	 If at any time you want to change where the Simple Object is bound to, repeat step 
2 above and the variables location will be updated.
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6.6.6	 Reuse a Generic PX Page
Saia PCD controllers often have the same control program and the associated Opera-
tor Views are identical, but reference data from different controllers. Or it is also possi-
ble that one controller has the same control program multiple times for multiple equip-
ment.

To reduce engineering time a PX Page with generic references to data in the controller 
can be re-used for multiple controllers by attaching it to the required controllers (points) 
in the Nav tree. In order to do this every reference from the PX page to the controller 
(points) must be made generic, and the PX Page must be associated with the controller 
or points folder.

Create generic PX page and make the ORDs relative:

1.	 Create a PX Page as required - see chapter 6.6.2	 Create a PX Page.

2.	 Open the Bound Ords pane.

3.	 Double click on the first ord that references a value in the controller. The Edit ord 
dialogue box is displayed. 
 

 
Original ORD in the Editfield: 
"station:|slot:/Drivers/SBC$20Systems/SBCIpNetwork_Demo/Device1/points/Heat-
ing1/Outside/Temperature/PhysVal"

4.	 Edit the ORD to make it generic by removing references to the site, LAN, and con-
troller. For example 
 

 
 

5.	 Click OK.

6.	 Press CTRL+S to save the page.
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Using Text Editor to make the ORDs relative
Text Editor can be used if more ORD has to be modified or the Relativize command 
can be used. 

1.	 Right mouse click to the page in the px folder to relativize

2.	 Select Views  Text Editor

3.	 The content of the px file is shown in XML format. 

4.	 Go to Menu bar Text editor and chose Replace. 
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5.	 fill up the Find edit filed and the Replace with edit field.  
 

6.	 Then click to Replace or All to replace one or all entries. 
 

Associate a PX Page with a controller:
1.	 Right click the PX Page that is to be reused and select Copy.

2.	 Right click the px folder in the Nav tree and select Paste. The Name dialogue box 
is displayed.

3.	 Enter a name for the PX Page (e.g. HC_generic).

4.	 Click OK.

5.	 In the Nav tree navigate to the controller that the page is to be associated.

6.	 Right click the controller and select Views > New View. The New Px View dia-
logue box is displayed. 
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7.	 Enter the name of the page created above in the View Name box.

8.	 Click OK	 The File already exists dialogue box is displayed. 
 

 
 

9.	 Click Reuse
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6.6.7	 New Px / responsiv elements

	� Menu bar automatically jumps to 
another position 

	� "Station" and "Hierachy" fold-
ers are no longer included in the 
browser nav tree

	� New "Flow Pane" offers the pos-
sibility to define the number of 
columns and the pagination by 
yourself 

6.6.8	 Dashboards
A Dashboard is an element on a PX Page which each user can customise to their re-
quirements.

To use dashboards the Dashboard palette needs to be opened and the Dashboard 
Service needs to be added to the Services section of Saia PCD® Supervisor. 

Dashboard panes are added to the PX view like any other Graphic, but it requires 
some extra configuration.
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6.6.8.1	 Add the Dashboard Service
1.	 In the Nav tree open 127.0.0.1(localhost)>Stataion(Demo_Station) > Config > 

Services.

2.	 Open the Dashboard palette and drag DashboardService onto Services. The 
Name dialogue box is displayed. 
 

3.	 Click OK.
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6.6.8.2	 Add a Dashboard to a PX Page
1.	 Create the PX Page as required.

2.	 Open the Dashboard palette and drag DashboardPane onto the page.

3.	 Open the webChart palette.

4.	 Drag either Chart or Circular Gauge onto the content of the Dashboard pane in 
the widget tree. 
 

 
 

 

5.	 Go online
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6.	 Drag & Drop an analog value to the gouge 
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6.7	 Set Up Saia PCD® Supervisor Users
Security of Saia PCD® Supervisor is controlled by users. The access rights of each 
user determines what information the user can access and what things they are able to 
change/configure.

To achieve this the security within Saia PCD® Supervisor is managed using three ser-
vices:

1.	 Categories 
Categories define what areas of the system a user can access.

2.	 Roles 
Roles are used to group the categories together that are required for a particular 
job and to define the level of access to those categories. 
 
E.g. a boiler engineer would only need access to the boilers but would require a 
high level of access. Therefore a role would be required for the engineers that gave 
high level access to the category that gave access to the boilers. 
 
An energy manager would need information from all the plant but with a lower level 
of access. Therefore a role would be required for the energy manager that gave 
low level access to a number of categories covering all the plant. 
 
Categories are assigned to roles using the Category Browser which is just another 
way of looking at the Nav tree.

3.	 Users 
Users define which roles the user has, their password, expiry, web access view. 
 
The ‘admin’ user is a superuser level access which has access to the whole sys-
tem. Because of this details of the admin user’s password should carefully con-
trolled. 
 
To configure users the required steps should be followed:
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6.7.1	 Configure Categories
Before creating the necessary categories it is necessary to plan what is required, you 
should consider the users and the distinct areas, then work out ‘Where’ needs to be 
granted access and create a category for each of these.

To configure categories the required steps should be followed:

6.7.1.1	 Add a Category
User and Admin categories are created by default and additional categories are added 
using the Category Manager.

The Admin category does not relate to the Admin user used to engineer Saia PCD® 
Supervisor.

1.	 In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > 
Services.

2.	 Double click CategoryService 
The CategoryBrowser is displayed in the view pane.

3.	 Click the view changer box and select Category Manager.  
The Category Manager is displayed in the view pane. 
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4.	 Click New	 The New dialogue box is displayed. 
 

 

5.	 Click OK	 The dialogue box changes. 
 

 

6.	 Enter the name of the category in the Name box.

7.	 Click OK.

6.7.1.2	 Set up the Categories
1.	 In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > 

Services.

2.	 Double click CategoryService 
The CategoryBrowser is displayed in the view pane. 
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3.	 Grant each category access to the required areas of the system by clicking the 
required rows in the column for each category. To grant access to elements lower 
in the hierarchy expand the appropriate row and click.

Categories are a parent child system so selecting the top level will grant 
access to every child element under that level.

 
The inherit feature enables the access of the User category to be copied to another 
category. If there is a tick on the Inherit column for a row when that row is selected 
for another category the access from the User category is copied to the other cat-
egory and removed from the User category. To reinstate access to the User cat-
egory click the row in the User column. 
 

Due to this it is potentially easy to accidentally remove rights.

 
A dot in a cell indicates access to that specific area. If the dot is black the access 
will not be affected by the Inherit tick, if it is grey it will be affected. 
 
It is recommended that the Admin category is given the same access in the Config 
row as the User category i.e. leave the Inherit rows in the Config row are they are. 
For the other rows (Alarm, Files, and History) the Inherit rows can be unticked to 
enable you to specify the access more easily. 
 

By default the ‘Admin’ and ‘New’ categories will have no access.

It is recommended that the ‘Admin’ category has access to some of 
the more complex areas of Saia PCD® Supervisor but not the whole of 
Saia PCD® Supervisor.

4.	 Click . 
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6.7.2	 Configure Roles
Roles use the categories to define what areas of the system can be accessed. They 
can have multiple categories assigned. It is best to configure Roles with job roles in 
mind rather than specific areas like categories.

1.	 In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > 
Services.

2.	 Double click RoleService	 The Role Manager is displayed in the view pane. 
 

 

3.	 Click New	 The New dialogue box is displayed. 
 

 

4.	 Click OK	 The dialogue box changes. 
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It is recommended that the SuperUser (access entire station, file system) 
check box is NOT selected.

5.	 Click >> next to Permissions.	 The Permissions dialogue box is displayed. 
 

6.	 Specify the permissions for each category by clicking the appropriate column for 
each category.  
 
When you assign permissions, higher-level permissions (green check marks) 
automatically include the lower level ones (grey check marks). For example, if you 
enable admin level write (W), the system automatically enables admin level read 
(R), as well as operator level read and write (RW). 
 
The first column, Category, lists the groups to which you may grant permission. 
The Operator and Admin columns relate to the permissions level configured on 
each component. Below these headings are the cells to use for assigning one of 
three permissions to each category: 
 

R Read allows the user to view the object.
W Write allows the user to change the object.
I Invoke allows the user to initiate an action related to the object.

 
Depending on how the permission level is set on the role, six permissions are de-
rived: 
 
Permission Description
To allow a user to view operator level 
information

Check the Operator config flag on the slot and select the Operator R 
column on the permission map.

To allow a user to modify operator level 
information (if it is not read only)

Check the Operator config flag on the slot and select the Operator 
W column on the permission map.

To allow the user to view and invoke 
operator-level operations (actions)

Check the Operator config flag on the slot and select the Operator I 
column on the permission map

To allow the user to view admin level 
information

Leave the Operator config flag unchecked on the slot and select the 
Admin R column on the permission map.

To allow the user to modify admin level 
information (if it is not read only)

Leave the Operator config flag unchecked on the slot and
select the Admin W column on the permission map.

To allow the user to view and invoke 
admin-level operations (actions)

Leave the Operator config flag unchecked on the slot and select the 
Admin I column on the permission map.
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7.	 Click OK.

8.	 Click OK	 A confirmation dialogue box is displayed.

9.	 Click Yes.

6.7.3	 Configure Users
To configure users the required steps should be followed:

see chapter 6.7.4	 Add Users  6.7.4

6.7.3.1	 Configure NAV Files
NAV files are used to define the PX Page that is displayed when a user logs in. Each 
user must have a NAV file assigned. It is recommend that a folder is created to store all 
the NAV files.

6.7.3.2	 Create a Folder for the NAV Files
1.	 Right click Files and select New> Folder. The Name dialogue box is displayed. 

 

 

2.	 Specify the folders’s name e.g. ‘NAV’.

3.	 Click OK.
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6.7.3.3	 Create NAV Files
1.	 In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config and 

navigate to where the NAV file is to be located 

2.	 Right click the folder and select New> NavFile.nav. The Name dialogue box is 
displayed. 
 

 
 

 

3.	 Specify the file’s name e.g. ‘Home’.

4.	 Click OK	 The file is created.

5.	 Open the folder containing the NAV file.

6.	 Double click the NAV file. The Nav File Editor is displayed in the view pane. 
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7.	 Click Show Components.

8.	 In the Result Tree double click to the NAV file. The Edit dialogue box is displayed. 
 

 

9.	 Click  next to DefaultView. The Select Ord dialogue box is displayed. 
 

 

10.	 Navigate to the PX Page that is to be referenced by the NAV page and select it.

11.	 Click OK.

12.	 Click OK.
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6.7.4	 Add Users
1.	 In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config > 

Services.

2.	 Right click UserService and select Views > AX User Manager. The Ax User Man-
ager is displayed in the view pane. 
 

 

3.	 Click New. The New dialogue box is displayed. 
 

 
 

Several users can be added at the same time. However, it is recommend-
ed to add users individually to prevent confusion when specifying pass-
words.

4.	 Click OK	 The dialogue box changes.
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5.	 Double click of the new user 
 

 

6.	 Enter the user’s username in the Name box.

7.	 Enter the users full name in the Full Name box.

8.	 If the user is to expire on a specific date select the Expires On option and specify 
the required date.

9.	 Select the roles for the user in the Roles box.

10.	 Enter the user’s password in the Password box. 
Passwords must be 10 digits alpha numeric with one or more capital 
letter.

11.	 Re-enter the user’s password in the Confirm box.
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12.	 To force the user to change the password when they next login set Force Reset At 
Next Login to true.

13.	 To force the user to change the password on a specific date, select the Expires On 
option and specify the required date.

14.	 If the password is to expire on a specific date select the Expires On option and 
specify the required date.

15.	 Specify the NAV file that is linked to the PX Page that is to be displayed when the 
user logs in in the Nav file box.

16.	 Specify what happens when a user logs in from a web browser in the Default Web 
Profile box.

17.	 In the Type box select the required option.

18.	 It is recommend that you select HTML5 Hx Profile as it will render the graphics in a 
HTML5 format avoiding Java issues.

19.	 In the Hx Theme box select “SBC”.

20.	 Select Yes or No to specify whether the user has access to the following features: 
 
- Hx workbench views 
- Nav tree side bar 
- search side bar 
- palette side bar 
- Nav file tree 
- Config tree 
- Files tree 
- Histories tree 
- Hierarchies tree

21.	 Click OK.
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6.8	 Backup & Restore
To ensure that the Saia PCD® Supervisor configuration can be restored in the event of 
hardware or software failure it is recommended that the Saia PCD® Supervisor station 
is backed up. To reduce the risk it is recommended that the backup is performed in two 
ways:

It is also important to ensure that the passphrase entered during the Saia PCD® Super-
visor installation, platform password (normally PC login credentials) and the password 
for the ‘admin’ user (specified when creating the Saia PCD® Supervisor station) are 
available for use during any restore procedure.
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6.8.1	 Backup the Configuration

Using the Station Copier
The Saia PCD® Supervisor configuration can be copied from the localhost back to the 
local computer. This is not a true back up but it is useful as it makes the configuration 
available offline and thus reusable in future Saia PCD® Supervisor installations.

1.	 In the Nav tree right-click on Platform and select Views > Station Copier. The 
Station Copier is displayed in the view pane. 
 

 

2.	 In the right-hand column (Stations on “localhost”) click the station to be copied (e.g. 
Saia PCD® Supervisor). 
 
The Localhost is the live version of Saia PCD® Supervisor. Copying from left to 
right will overwrite the live version with an older PC version. To copy the live ver-
sion to the PC it is RIGHT to LEFT 

3.	 Click < Copy. The Station Transfer Wizard is displayed. 
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4.	 Enter the name of the backup copy (e.g. Saia PCD® Supervisor Backup).

5.	 Click Next.  
 

 
 

 

6.	 Select Copy every file in the station directory and its subdirectories.

7.	 Click Next.

8.	 If the station already exists in the destination you will be prompted to delete the 
entire station, or just overwrite duplicate files. Select the required option and click 
Next. 
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9.	 Click Finish to start copying the files. Once the copy is complete the following dia-
logue box is displayed. 
 

 

10.	 Click Close.

11.	 In the Nav tree open My File System and navigate to  
	 C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/stations 

12.	 Right-click the required station folder and select Copy.

13.	 Navigate to the required storage location (e.g. a plug-in memory device).

14.	 Right-click and select Paste.
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6.8.2	 Using the Backup Service
Using the Backup Service the backup file has not only the content of the station but 
also the default settings of the Workbench where the station was created and backed 
up. 
The user can as well specify, if the alarm or histories database should be a part of the 
backup .dist file. 
 
Doing a station backup, will prevent data-lose of the running station in case of hard-
ware or system failure.

Station backups are stored as ‘.dist’ files in  
	 C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/backups 

1.	 In the Nav tree open Station > Config > Services.

2.	 Right click BackupServices and choose Views > Ax Property Sheet. 
 

 

3.	 In the Exclude Directories box click file:^^history and click .

4.	 In the Exclude Directories box click file:^^alarm and click .

5.	 Click Save.
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6.	 In the Nav tree double click BackupService. The Backup Manager is displayed in 
the view pane. 
 

 

7.	 Click Backup. The File Chooser dialogue is displayed. 
 

 

8.	 If required rename the backup in the File name box.

9.	 Click Save.

10.	 Ensure the backup file is stored securely.
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6.8.3	 Restore the Configuration
6.8.3.1	 Restore Using the Station Copier

To restore a station copy follow the procedure described in chapter  
6.8.1 Backup the Configuration but copy the station from left to right.

6.8.3.2	 Restore the Station Using the dist file
1.	 Rename the backup.dist file to a zip by renaming the extension and unzip it.

2.	 Copy the unziped station to the User home station folder. 
 

3.	 Use the station copier to copy it to the daemon home and start. 
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6.9	 SBC S-BUS driver in Optimizer Advanced Controller
The driver support within the Optimizer Advanced Controller is positioned with respect 
to the SBC portfolio. It is intended to provide means for the SBC partners to migrate the 
existing PCD (Building Management) to a Niagara based Optimizer Solution which es-
tablishes a horizontal integrated solution. This will use the existing S-BUS- IP within the 
Advanced Controller without any functional changes. Within the existing S-BUS driver, 
the Advanced Controller can act as the S-Bus Primary device, which means it can read 
and write from any PCD that has ethernet connection. This also allows the Advanced 
Controller to be integrated into the existing SBC PCD® networks.

The image below is the representation of the horizontal integration of the Advanced 
Controller with the existing Saia PCD® Supervisor.

6.9.1	 System Architectute

6.9.1.1	 Focus on Enhancing Connectivity with Optimizer Suite Hardware

BACnetTM IP
Unitary Controller

BACnetTM T1L
Unitary Controller

BACnetTM MS/TP
Unitary Controller

No S-Bus
FOX
BACnet
Etc.

Optimiser Advanced
Controller

No S-Bus
BACnet
Etc.

T1L Switch

T1L

No FOX
S-Bus
BACnet
Etc.

Saia PCD Supervisor

RS-485

Ethernet

PCD Controller

-> PCD Sub-StationsRS-485

Ethernet communication to Sub-PCD Stations over RS-485 which are connected behind 
a gateway.
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6.9.1.2	 Focus on Enhancing Connectivity with Saia PCD Hardware

PCD7.D410DT5F
PG5 programmable
MB Web-Panel

Saia PCD Supervisor

-> Optimiser Suite HW

RS-485

Ethernet

Ethernet

Optimiser 
Advanced
Controller

No S-Bus
Modbus

PCD1.M2110R1
as Sub-Station

PCD 1 E-Line
programmable I/O modules

No FOX
S-Bus
BACnet
Etc.

No S-Bus
FOX
BACnet
Etc.

PCD Controller

RS-485S-Bus
Modbus

PCD1.M2110R1
as Sub-Station

PCD 1 E-Line
programmable I/O modules

6.9.2	 Optimizer Advanced Controller communication with existing PCD.
6.9.2.1	 Prerequisites 

1.	 The user should ensure that the below listed modules/software version is available 
before starting the Advanced Controller integration with SBC.

	- List of compatible modules/software
	- SBC PCD Workbench
	- SBC Supervisor Package

2.	 The first step is to configure and commission the Advanced Controller, that needs to 
communicate with the existing SBC PCD network. This controller needs to be in the 
same Subnet or LAN as that of the Saia PCD® Supervisor. In case otherwise, the 
firewall needs to be opened between different Subnets. 

3.	 Follow the below listed procedure to configure the Optimiser Advanced Controller:

	Æ To install the Advanced Controller, refer the Mounting Instructions document (31-
00553).

	Æ Connect the power Supply.

	Æ Connect the controller to workbench.

	Æ Ensure that the supported modules are available in the workbench

	Æ Copy the station/Create a station/Open a station.

Refer to the Advanced Installation Instruction and Commissioning Guide - 31-00584 for 
following the above listed procedures.

Ethernet communication to Sub-PCD Stations over RS-485 which are connected behind 
a gateway.
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4.	 Once the controller is completely set up the S-BUS station needs to be created in 
the application director, and it should be up and running. Please refer to point 6.1.3 
for creating the station.

5.	 Under this station the S-Bus IP driver needs to be added. Lastly all the S-Bus de-
vices need to be added under this driver to start the communication with the Opti-
mizer Advanced Controller.

6.9.3 	 Procedure to add the S-BUS IP driver: 
1.	 This procedure can be referred from section 6.2 in the Saia PCD® Supervisor V3.0 

Configuration Manual. 

6.9.4 	 Procedure to add the S-BUS IP driver (SBCIpNetwork)
1.	 The SBC-IP driver needs to be added under the station file. As shown in the Fig 

below navigate to drivers under the desired station. 
 



6-160

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Backup & Restore

Creating/Engineering a project

6

2.	 Click on drivers to add the SBC-IP driver as shown below. The driver section can 
have multiple drives such as Niagara, BACnet etc. 
 

3.	 From the palette, look for module SBC (SBC IP DRIVER) in the search window and 
drag and drop it under the driver section of the station. 
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4.	 Name the S Bus IP driver as desired name, when the below window pops up. 
 

5.	 Once created, click on the SBC-IP network that is added and go to the property 
sheet as shown below. 
 

6.	 Once created, click on the SBC-IP network that is added and go to the property 
vsheet as shown below. Check for status it should be {ok} and enable tab should be 
True. 
 

To enable the service, make the service true. True is to Enable and false is to disable 
service.
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7.	 After enabling the services, we need to add the devices that needs that need to 
communicate with the Advanced Controller. For this go to the pallet and look for the 
PCD device. Drag and drop the PCD device under the S-Bus IP as shown in the 
image below. 
 

8.	 After adding the required PCD, device we need to configure the IP address and 
station ID for the device. Click on the device and navigate to the property sheet as 
shown below. 
 

While commissioning the PCD the IP address, Port number and station ID’s are as-
signed, same details need to be filled in this property sheet as well.
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9.	 In similar way, using the drag and drop method we can add the points to be moni-
tored under the head PCD station. 
 

10.	 Once added, go to the property sheet view to add the memory address of the 
points that has just been added. After adding the memory address, this will start 
communicating. 
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7	 Using Saia PCD® Supervisor

This section covers the general procedures for day-to-day use of Saia PCD® Supervi-
sor. 

Once configured Saia PCD® Supervisor needs to be running all the time to enable to 
collect logged data, control occupation times, process alarms and allow users to ac-
cess information.

If AUTO-START was selected when the Saia PCD® Supervisor station was created, the 
Station will be running whenever the PC is started and running. 

If this is not the case the Saia PCD® Supervisor station must be started manually 
see chapter 7.3	 Manual start the Saia PCD® Supervisor Station

Go to ..

7.1	 Access Saia PCD® Supervisor

“7.2	 Use Saia PCD® Supervisor”

7.3	 Manual start the Saia PCD® Supervisor Station

7.4	 HTML5 Enhancements

7.5	 Cloud Connector

7.6	 Bulk deploy

7.7	 VykonPro modules (on request)

“7.8	 Setting customized login and background logo”

“7.9 	Headstation and Substation Ping Read Timeout”

“7.10 	 Setting up the S-Bus clock”

“7.11 	 Use of UDP config slot from the Property sheet in every headsta-
tion”
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7.1	 Access Saia PCD® Supervisor
Saia PCD® Supervisor can be accessed from a PC using the Saia PCD® Supervisor ap-
plication or from a web browser.

When accessing Saia PCD® Supervisor from a web browser not all features are avail-
able.

7.1.1	 Launch the Saia PCD® Supervisor Application
1.	 Click Start and choose All Programs.

2.	 Navigate to the Saia PCD Supervisor folder 

3.	 Click Saia PCD Supervisor v1.0R
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4.	 The Saia PCD® Supervisor application window will open: 
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7.1.1.1	 Log on
 (of course the Platform must be running always).

1.	 In the Nav tree double click on Station. The Authentication dialogue box is dis-
played with a default user selected: 
 

 

2.	 To select a different user click Change User, otherwise go to step 5. 
 

 
 

Select the Remember this user tickbox to make this the default username.

3.	 Enter a new Username.

4.	 Click OK.

5.	 Type the appropriate password in the Password box.

6.	 Click OK	 The user associated navigation (and start page) will be invoked

7.1.1.2	 Log off
1.	 When you have finished using Saia PCD® Supervisor it is important to log off from 

Saia PCD® Supervisor to ensure that the system cannot be accessed by unau-
thorised users. Logging off requires you to disconnect from both the Platform and 
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Station.

2.	 In the Nav tree right-click on My Host and select Disconnect. The Disconnect 
dialogue box is displayed. 
 

	  

3.	 Click Yes to disconnect.

7.1.2	 Access Saia PCD® Supervisor from a Web Browser
1.	 Go to the IP address of the PC running Saia PCD® Supervisor. The Saia PCD® 

Supervisor log on page is displayed. 
 

 

Please contact your local IT-department to get certificate!
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2.	 Proceed to localhost 
 

  
 

3.	 Enter your user name.

4.	 Click Login.

5.	 Enter your password.

6.	 Click Login. 
 

If the correct certificates, are installed then the security warning is not 
coming up. The connection is immediately built from the browser to the 
server.
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7.1.2.1	 Log off
1.	 Click “X” 

 

2.	 Click Yes.
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7.2	 Use Saia PCD® Supervisor
Once you have accessed Saia PCD® Supervisor it can be used in two different ways:

	Æ 7.2.1	Using Saia PCD® Supervisor via Operator Views

	Æ 7.2.2.2	 Nav Tree

The method you use will depend on how Saia PCD® Supervisor has been configured, 
your level of access and the tasks you want to do.

7.2.1	 Using Saia PCD® Supervisor via Operator Views
Use of Saia PCD® Supervisor via Operator Views (PX Pages) requires more initial 
configuration, but enables users to access the system using graphical pages tailored to 
their requirements in a controlled way.

The Operator Views will have been designed to provide clickable links to either move 
between pages or select particular controls (e.g. to change a set point, change occu-
pancy times, etc). When you log in you will be taken to a landing page from which you 
can navigate to the required information and, if allowed, make adjustments. Simply 
click on the links provided; the user interface should make it obvious what the link does.

7.2.1.1	 Access the Operator Views
When you log on a PX Page will normally be displayed allowing you to navigate to 
parts of the system that you have access to. 

If a PX Page is not displayed and you want to navigate the system using Operator 
Views you will need to display the required page from the Nav tree.

1.	 In the Nav tree open  
127.0.0.1(localhost) > Station(Demo_Station) > Files > PX >  and navigate to the 
required PX Page (start page). 

2.	 Double click the page. 

7.2.1.2	 Use the Operator Views
Navigation
Once a PX Page is displayed you will be able to navigate to other parts of the system 
by clicking on the links provided. These links may be in the form of text hyperlinks but-
tons, or graphics with hyperlinks depending on how the page has been configured. The 
display should make it clear the function of each item on the page.
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The next and previous buttons ( ) can be used to move between the pages you 
have already viewed.

Adjustments
If you have the authority and the page has been configured appropriately you may be 
able to make adjustments by clicking on various graphical elements, e.g. sliders and 
buttons. 
			        

The meaning and use of such items should be intuitive.

7.2.1.3	 Use Dashboards
A Dashboard is an item on a PX Page that enables you to choose the information that 
is displayed. Once you have set up the item it can be saved so that next time you visit 
the page your selections are visible. Selections made by other users do not affect 
yours. A PX Page may contain one or more dashboard items.

There are two types of dashboard item; Gauges and Charts.

Gauge
A gauge type dashboard appears as shown below and enables an analogue value to 
be represented in a graphical way.

Un configured Configured
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Chart
A chart type dashboard appears as shown below and enables values to be represented 
as a graph, e.g. histories. Time schedules can also be added enabling you to view the 
occupancy state and when a parameter is at a certain value.

ConfiguredUn configured

7.2.1.4	 Configuring a Dashboard

Configuring a dashboard requires access to the Nav tree.

Adding an item to a Dashboard
	- Use the Nav tree to locate the point required.

	- Drag the point onto the dashboard. For charts you can add more than one value.

•	
Save a Dashboard
•	 Click  on the dashboard. 

 



7-11

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Use Saia PCD® Supervisor

Using Saia PCD® Supervisor

7

7.2.2	 Using Saia PCD® Supervisor via the Nav Tree

7.2.2.1	 Basic Controls and Navigation
To see the location of the following Saia PCD® Supervisor controls and features, refer 
to the diagram on chapter “2.2	 User Interface Application (Host PC)”

7.2.2.2	 Nav Tree
To show the side bar:
	- On the menu bar select Window > Side Bars and ensure Show Side Bars is 

checked. 

To add a Nav tree to the side bar:
	- On the menu bar select Window > Side Bars > Nav.

•	
To remove a Nav tree from the side bar:
	- Click the arrow to the left of the Nav tree title and select Close.

7.2.2.3	 Palettes
To show the side bar:
	- On the menu bar select Window > Side Bars and ensure Show Side Bars is 

checked.

To add a Palette to the side bar:
	- On the menu bar select Window > Side Bars > Palette.

	- Click the file icon and select the Palette type from the displayed options.

To remove a Palette from the side bar:
	- Click the arrow to the left of the Palette title and select Close.

7.2.2.4	 Locator Bar
To navigate down the hierarchy:
	- Holding the mouse over an item: a small arrow will appear. 

	- Click the arrow to reveal a drop down box and select the required option.

•	
To navigate up the hierarchy:
	- Click on an item in the bar to navigate back to that level. 
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To navigate to specific location:
	- Click in a blank area of the locator bar and type the path directly into the box.

7.2.2.5	 View Pane & View Changer
To change the view of a selected item:

	- Click the view changer box and choose the required view. 
  Or 
Right-click the item (e.g. in the Nav tree), then select Views > and the required 
view.

7.2.2.6	 Viewing and Changing values of a Point
To view a point value:
	- Use the Nav tree to locate the point required.

	- Double click the point (or right-click and select Views > AX Property Sheet) to view 
its Property Sheet. The Out item will indicate the current point value.

To change a point value (writable points only):
1.	 Use the Nav tree to locate the point required, right-click the point and select  

Actions > Set Value. 
   Or 
Click the button that allows the value to be adjusted. 
 
The Set dialogue box is displayed. 
 

 

2.	 Type the required value. 
As default Saia PCD® Supervisor does not check that the value entered is 
valid. The limits can be set for Numeric Writable. When the operator types 
value outside of the limits the value will not be accepted.

3.	 Click OK.
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7.2.2.7	 Viewing Alarms
Viewing Alarms Using the Alarm History
1.	 In the Nav tree open the Services folder (under Station > Config).

2.	 Right-click AlarmService and select Views > Alarm Db View. The Alarm History 
is displayed in the view pane. 
 

3.	 Use the selector box (top left) to choose the required period.

It is recommended that the Saia PCD® Supervisor user need to use the 
updated station in order to load the SBC Alarm Console page correctly.
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7.2.2.8	 Using the Alarm Console
The Alarm Console allows you to view details of each alarm, acknowledge an alarm or 
add notes to alarms. Notes are useful to record actions (particularly for critical alarms) 
such as who has been notified, contact numbers and agreed timescales for fixing the 
problem.

To view specific alarm details:
1.	 In the Nav tree open the Station > Config > Services folder.

2.	 Double click AlarmService. The view pane will display the Alarm Service wire 
sheet.

3.	 Double click on the required ConsoleRecipient to open the Alarm Console: 
 

 
 
 

 
 

Current alarms are indicated by a red icon, retuned to Normal alarms are 
indicated by a green icon.
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4.	 Double click an alarm line to open the Alarm Viewer. This will list all current and 
cleared alarms related to the same alarm condition: 
 

 

5.	 Double click an alarm to open the Alarm Record, giving full details of the alarm. 
 

 

To acknowledge an alarm:
1.	 Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record 

for a specific alarm.

2.	 Click the Acknowledge button. 
Multiple alarms can be selected and acknowledged at the same time in 
the Alarm Console or Alarm Viewer by clicking in conjunction with CTRL 
and/or Shift keys.
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To view or add notes for an alarm:
1.	 Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record 

for a specific alarm.

2.	 Click the Notes button. The Notes window is displayed and any previously added 
notes will be shown with a timestamp in the top section: 
 

 

3.	 Type any new details in the lower section and click the Add Note button to save, or 
click Close to close the window without adding a new note. 

You cannot add notes to multiple alarms.

7.2.2.9	 Viewing and changing Occupation Times (Scheduler and Calendar)  
in Saia PCD® Supervisor

Changing the Weekly Schedule
The weekly schedule determines the occupation times for a normal week, i.e. no Spe-
cial Events apply.

1.	 In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired WeeklySchedule.

2.	 Double click the WeeklySchedule. The Scheduler is displayed in the view pane. 
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3.	 Select the Weekly Schedule tab.

4.	 Specify the required occupation times: 
 
To add a new time period: 

Drag the mouse in the required white area of the grid.
To make adjustments to existing time periods: 

Drag the top or bottom edge of the green rectangles to the required time. 
To set all day occupation: 

Right click the day and select All Day Event.
To a apply a period a day’s times Monday to Friday: 

Right click the day and select Apply M-F.
To remove a time period: 

Right-click the rectangle and select Delete Event.
To remove all time periods for a day: 

Right click the day and select Clear Day.
To copy a day: 

Right click the day and select Copy Day then right click the day the times 
are to be copied to and select Paste Day.

5.	 Click Save.

Editing Special Events
Special events enable different occupation times to be used on specific days.

1.	 In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired BooleanSchedule.

2.	 Double click the WeeklySchedule. The Scheduler is displayed in the view pane.

3.	 Select the Special Events tab. 
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4.	 Specify the required Special Events:

Add a special event
1.	 Click Add. The Add dialogue box is displayed. 

 

 

2.	 Specify a name for the special event in the Name box.

3.	 Select Date or Date Range in the Type box. 
 
Specify the date(s) the special event applies to: 
Date: Specify the day month and year in the appropriate box. 
Date Range: Specify the day month and year for the beginning of the range in the 
appropriate box in the top row and specify the day month and year for the end of 
the range in the appropriate box in the bottom row

4.	 Click OK. 
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Edit the times
•	 Click the special event for which the times are to be edited.

To add a new time period: 
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods: 
Drag the top or bottom edge of the green rectangles to the required time. 

To set all day occupation: 
Right click the day and select All Day Event.

To remove a time period: 
Right-click the rectangle and select Delete Event.

To remove all time periods: 
Right click the rectangle and select Clear Day.

To ensure non-occupancy outside the specified periods  
Right click the day and select Schedule Defaults.

Rename a special event
1.	 Right click the special event that is to be renamed.

2.	 Click Rename. The Rename dialogue box is displayed. 
 

 

3.	 Enter the new name. 
 

 

4.	 Click OK.

5.	 Delete a special event

6.	 Right click the special event that is to be deleted.
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7.	 Click Delete. The Confirm dialogue box is displayed. 
 

8.	 Click Yes.

9.	 Click Save.

Editing the CalendarSchedule
If a CalendarSchedule has been added to specify days different occupation times are 
used, these days can be edited by add or removing events from the CalendarSchedule.

1.	 In the Nav tree open Localhost > Station(Demo_station), navigate to the required 
CalendarSchedule.

2.	 Double click the CalendarSchedule. The Scheduler is displayed in the view pane.. 
 



7-21

Saia-Burgess Controls AG

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG11 | 2025-03 

Use Saia PCD® Supervisor

Using Saia PCD® Supervisor

7

Add a date
1.	 Click Add. The Add dialogue box is displayed. 

 

2.	 Specify a name for the special event in the Name box.

3.	 Select Date or Date Range in the Type box. 
 
Specify the date(s) the special event applies to: 
Date: Specify the day month and year in the appropriate box. 
Date Range: Specify the day month and year for the beginning of the range in the 
appropriate box in the top row and specify the day month and year for the end of 
the range in the appropriate box in the bottom row.

4.	 Click OK.

Edit a date
1.	 Double click the date that is to be edited. 

2.	 Edit the date as required.

Rename a date
1.	 Right click the date that is to be renamed.

2.	 Click Rename. The Rename dialogue box is displayed. 
 

 

3.	 Enter the new name. 
 

4.	 Click OK
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Delete a date
1.	 Right click the date that is to be deleted.

2.	 Click Delete. The Confirm dialogue box is displayed.

3.	 Click Yes.

4.	 Click Save.

7.2.2.10	 Viewing a History (Graph)
1.	 In the Nav tree open the History folder (Station > History).

2.	 Open the folder for the required controller.

3.	 Double click on the history that you wish to view. The Chart view is displayed. 
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Viewing Multiple Plot Graphs

To add another plot to the same chart: 
Drag the required history from the Nav tree onto the Chart view.

Adjusting the Displayed Information

To change the displayed time period: 
Use the selector (at the top left of the Chart view) to choose the required 
time period.

To change the horizontal scale: 
Mouse over the appropriate scale until the cursor changes to a double ar-
row. 
Drag the mouse left or right to change the scale.

To change the vertical scale: 
Mouse over the appropriate scale until the cursor changes to a double ar-
row. 
Drag the mouse up or down to change the scale.

Viewing the Source Data

To view the source data in table form: 
Click the View Changer and select History Table.

Exporting a Graph or Data Table
1.	 In the Nav tree, right-click on the required history and select Export. The Export 

dialogue box is displayed.

2.	 In the Select Exporter box select the required export type and file format.

3.	 Choose the export method (e.g. Save to File).

4.	 Click OK.

Viewing Live Updates
1.	 View the desired plot (as described above) and change the view to History Chart.

2.	 Click the Play button  to start getting history updates. At the bottom right corner 
of the window the message ‘Waiting on first Live Update...’ will appear.

3.	 When the time period has elapsed the message will change to show ‘Last Live 
Update’ with the date and time of the update. 
 

If you zoom in on the chart, live updates will not be visible anymore. If you 
need to see values that are not visible on the chart you need to switch to 
History Table view 
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7.3	 Manual start the Saia PCD® Supervisor Station
1.	 In the Nav tree open  

My Host > Station(Saia PCD® Supervisor) > Platform > Services.

2.	 Double click Application Director. The Application Director is displayed in the 
view pane. 
 

3.	 Click Start. 
The station will be started, check that a ‘Station Started’ message is shown. 
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7.4	 HTML5 Enhancements
Improved and newly created base templates for improved usability, also for mobile 
devices.

	� Time program view improved
	z (complete in HTML5)

	� Alarm console new
	z (complete in HTML5)
	z Improved use of available space
	z Responsive: details fold-out, automatic scaling

	� Role manager new
	z (complete in HTML5)
	z Improved use of available space
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7.4.1	 New reporting functions

	� All reporting visualizations are fully inte-
grated in HTML5 

	� Responsive design for mobile devices

	� Can now also be used in the dashboard

	� Improved export functions

	� Predefined examples in the palette

	� NEQL and BQL can be combined

7.5	 Cloud Connector
Enables station to establish secured connection to the cloud

	� Reduction of operating costs
	� Improved uptime, reliability and energy 

efficiency
	� Reduce data loss with automatic backup 

service
	� Included in installation and at no ad-

ditional cost - Part of Software Mainte-
nance Service (SMA)

	� First cloud offers: 
	z Backup as a Service (BaaS) - offers 

secure and scalable backups in the 
cloud (Available from Tridium)

	z Action management - manage com-
mon priority problems from anywhere 
using the app

	z Performance Analysis - Automatic Er-
ror Detection and Notification
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7.6	 Bulk deploy
A single action can create multiple instances of one or more templates on a station

	� The mass provision process includes these primary steps:
	z Select a template and create an Excel file from it
	z Each Excel worksheet contains a row with the unique information required by 
each Device

	z This “customized” Excel file is selected for mass implementation and extracts all 
configurations into the respective Devices

7.7	 VykonPro modules (on request)
The VykonPro module is a collection of station components and px widgets that are 
provided as a value add to the Vykon channel partners. The station components and 
px widgets only function in a station whose license is branded Vykon (brandId=”vykon” 
or brandId=”vykon.security”). There are no extra features required in the license file for 
the components to function. 

	� These tools are designed to save 
programming time, extend the standard 
offering, and help with system develop-
ment

	� A demonstration station called "vy-
konProTest" is available from Niagara 
Central

	z The station shows how each single 
component can be implemented in 
the vykonPro modules
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7.8	 Setting customized login and background logo
This chapter describes how an user can add and save the customized station login 
design with customized background logo.

Adding slots for customized login and background logo
1.	 In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Services.

2.	 Click on WebService. 

3.	 Go to the AX Slot Sheet view from the View Selector. 

4.	 Right click on the page and select Add Slot. 

5.	 The Add Slot dialogue box is displayed. Type the correct and same name in the 
Name area. Select the required Type. User can select baja Ord or baja String. 
Click OK. 
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6.	 Similarly, create one more slot for the css login. Click OK. 
For more details on how to add or edit a Slot, refer to Tridium Niagara 
documentation docuser file which is available in the Niagara workbench.

7.	 Go to the AX Property Sheet view from the View Selector. 

To set the customized logo background colour:
1.	 Go to the newly added logo property.

2.	 Click Folder icon. The File Chooser dialogue box is displayed. 

3.	 Select the required logo image file. 
 

4.	 Click Save to apply your changes.

To set the customized css login:
1.	 Go to the newly added css login property.

2.	 Click Folder icon. The File Chooser dialogue box is displayed. 

3.	 Select the required css file with login details.

4.	 Click Save to apply your changes.
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To retain customized css login and logo after the station restart:
1.	 Go to the Force Custom Login Settings at Restart property. 

 
In order to access Force Custom Login Settings at Restart property, user 
must add the GalileoService in the Nav tree under the Services portal from 
Palette. For more details, refer to Tridium Niagara documentation docuser 
file which is available in the Niagara workbench.

2.	 To retain customized css login and logo even after the station restart, select the 
Force Custom Login Settings at Restart property to true. 
 

 

3.	 To override customized css login and logo on station restart, select the Force  
Custom Login Settings at Restart property to false. 

7.9 	 Headstation and Substation Ping Read Timeout
The communication between the headstation devices and substation devices is critical 
and need to ne consistently synchronous. Particularly for the substations, it takes more 
time to get the response for the request sent compared to the headstation. 

To overcome this difference, a new “Headstation Ping Read Timeout” property slot is 
introduced in Headstation devices. Similarly, a new “Substation Ping Read Timeout” 
property slot is introduced in Substation devices and the read timeout is increased from 
250 millisecond (ms) to 4000 millisecond (ms) by default.

This conversion is only valid for SBC specific media types.

Using a Headstation Ping Read Timeout property slot:
1.	 In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.

2.	 Go to SBCIpNetwork and select the Headstation.
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3.	 Go to the AX Slot Sheet view from the View Selector. 

4.	 Select the Headstation Ping Read Timeout property from the Slot list. Right click 
on it and select Config Flangs. 

5.	 The Config Flags dialogue box is displayed. Remove the selection of Hidden flag. 
 

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

 

6.	 Click OK.

7.	 Go to the AX Property Sheet view from the View Selector.  
 

8.	 The Headstation Ping Read Timeout property slot is now listed in the Property 
sheet with default value of 250 ms. This value is user configurable ranging from 
250 ms to 20000 ms.
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Using a Substation Ping Read Timeout property slot:
1.	 In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.

2.	 Go to SBCIpNetwork > Headstation > Substation.

3.	 Go to the AX Slot Sheet view from the View Selector. 

4.	 Select the Substation Ping Read Timeout property from the Slot list. Right click 
on it and select Config Flangs. 

5.	 The Config Flags dialogue box is displayed. Remove the selection of Hidden flag. 
 

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

6.	 Click OK.

7.	 Go to the AX Property Sheet view from the View Selector.  
 

8.	 The Substation Ping Read Timeout property slot is now listed in the Property 
sheet with default value of 4000 ms (4 seconds). This value is user configurable 
ranging from 250 ms to 20000 ms.
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7.10 	 Setting up the S-Bus clock
A new SBC Clock feature enables you to set the seven day clock which captures 14 
times. Each day can be assigned with two values, On or Off. Also the same set SBC 
Clock points can be read and write to the Saia PCD devices.

To add a S-Bus clock
1.	 Click on the folder icon under Palette. Open Palette dialogue box is displayed.

2.	 Select SBC IP Driver from drop down list. “Points” palette will be displayed under 
Palette window area.

3.	 Go to Points. Select SBCClock and then drag and drop it to the Points folder of 
required station or device under Nav. tree.

4.	 Now, the SBCClock Point is added under tree. Click SBCClock.

5.	 Set On or Off status for selected day (Monday to Sunday). Then, add the time in 
the form of integer number type.  
For example:	Selected Day to Write - Monday On 
		  Value for Selected Day - 1220.

6.	 Click Save to save data to supervisor.

7.	 To write the saved values into the controller/device, right-click on the AX Property 
Sheet. Go to Actions > Set. 
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7.11 	 Use of UDP config slot from the Property sheet in every headstation
To overcome the issue of exception from the overfilled stack, every workstation is 
added with one UDP channel from version 3.0. Now, each headstation can process 
32 transaction threads which can help to process received and sent requets. This will 
enhance the communication speed and performance. 
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8 	 Saia PCD® Supervisor - Point View Widget

8.1	 Introduction
8.1.1	 Purpose and Deliverables of the Point View Widget

The Point View Widget is a browser-based interface designed for BEMS (Building 
Energy Management System) users in order to perform the most common operations 
requested to maintain and run any BEMS system efficiently.

The point view widget is interconnected with the standard Niagara user administration. 
This provides a customized solution considering individual user requirements (restric-
tions) when working with point lists. The Niagara user administration allows any kind of 
deep-structured definition for users. As an example, 3 typical BEMS user types (pro-
files), each having specific prerequisites and operational needs, are described in the 
following:

Operator

•	 Familiar and comfortable with software based on standard browser technology
•	 No knowledge of BEMS internals
•	 Individual user access possible by user privilege management
•	 Viewing core information of points: value, status, alarms, and logs
•	 Search for names using wildcards
•	 Operations applicable to multiple points in one step
•	 Quick filtering for points in alarm, in overridden state, and with logs
•	 Saving point lists as favourites
Service Manager

•	 The service manager can apply all functions of the operator. In addition, the servic 
manager can:
	- Apply multi-string search with no need to know SQL
	- Present and extract data as Excel report
	- Easily access historical data and display point logs
	- Convert complex schematics into an easy understandable tabular format for 

a comprehensive overview of system health status
Partner

•	 Has super-user (admin) rights and can apply all functions of the operator and ser-
vice manager

•	 As a superuser having excellent expertise, he is able to design individual user 
profiles (e.g. operator, service manager, etc.) which allow these users to take out 
the required information from the BEMS effectively based on the usage of the point 
view widget

•	 Needs less pre-engineering and post-customization to support the users 

For detailed instructions on how to create user profiles using the Niagara user adminis-
tration, we recommend a training that can be provided by the corresponding Honeywell 
TAC department.
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8.2	 Prerequisites
In order to run the Niagara Supervisor and make use of the point view widget, make 
sure, that the following prerequisites are fulfilled:

•	 Niagara 4.7 is installed on the PC
•	 The Modules folder contains the following Galileo modules: 

	- galileoPointListWrapper-rt
	- galileoPointViewer-rt
	- galileoPointViewer-ux
	- galileoSignalR-rt

•	 The Niagara Workbench is started
•	 The platform is connected
•	 The station is running and connected
•	 The Galileo services “PointListViewService” and “SignalService” are available in 

the “Services” folder. If the station is originally created based on a Tridium template, 
please refer to the “Selecting the Right Station Template “, page. 6 section for add-
ing the missing services to the station.

8.2.1 	 What's new with Niagara 4.7?
Point-List-View

•	 Standard view is now selectable
•	 PLV at global system level (no more missing data points)
•	 Tooltip for description
•	 Points are updated after station restart
•	 History extensions are also displayed via the log icon
•	 Set / Override are configurable 
•	 The PLV correctly displays the decimal places defined in the lexicon file
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8.2.2 	 Selecting the Right Station Template
In order to apply the point view widget, select the brand-specific template when creat-
ing the station, e.g. the Saia PCD Supervisor System template for the Saia Burgess 
Controls AG brand. This adds the required services to the Services folder automatically.

If the station is created using a Tridium template, you must manually add the required 
services from the “galileoPointViewer” and “galileoSignalR” palettes to the Services 
folder as described in the following:

Procedure

1.	 In the Palette pane, open a new palette by clicking the Open icon. 
 

RESULT: The Open Palette dialog box displays.

2.	 Enter ´galileo` or the first part of the string in the search field.  
 
RESULT: The galileo items are displayed.  

3.	 	Select e.g. ´galileoPointViewer` at first.  
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RESULT: The ´PointListViewService` is displayed. 

 
4.	 Select the ´PointListViewService` in the Palette, and then drag&drop it to the Ser-

vices folder in the Nav tree. 

 
 
RESULT: The Name dialog box displays. 
 

5.	 If desired, change the name, and then click the OK button. 
 
RESULT: The ´PointListViewService` is added to the Services folder in the Nav tree. 
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6.	 Add the ´SignalService` in the same way to the Services folder (see the following 
screenshots). 
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8.3 	 Starting Niagara Supervisor
Procedure

1.	 Open your browser and enter the IP address, URL, or hostname into the address 
field.

2.	 If your browser does not allow a secure https connection, continue by applying the 
unsecure mode provided by the browser.  
 
RESULT.	 The Login dialog box displays showing the name of the station, in 
this case “Demo”, in the title line. 
 

 

3.	 If not already displayed in the Username field, enter your user name, and in the 
Password field, enter your password.

4.	 Click the Login button. 
 
RESULT: The Station window displays. The Nav tree is shown on the left and the 
Config folder is pre-selected.  
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8.3.1 	 Enabling Point View Widget
The points of the station to be displayed via point view widget can be located in any 
driver and/or Niagara folder. 

Procedure

1.	 After login (see “Starting Niagara Supervisor” section), expand the Config folder 
and browse to the Home folder which typically displays the building graphically.

2.	 Double-click the Home folder. 
 
RESULT:	 On the right pane, the building graphic displays.  
 

3.	 Navigate to the plant by clicking the Plant button in the graphic.  
 
RESULT.	 On the right pane, the plant graphic displays.  
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Or in 2D: 

4.	 On the upper right corner, click the drop-down listbox and then click on Point View 
Widget in the menu. 

 
 
RESULT. On the right pane, the point list displays. By default, the list is displayed in 
the Default View. 

 
For a detailed description of the point view widget screen, please refer to the subse-
quent “Point View Widget Description” section, page 146.
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8.3.2 	 Engineering Mode
When PointListViewService is activated the detail pane on the right side uses as de-
fault the PointView Widget. 

Niagara default views assigned to the hierarchy elements listed in the tree on the left 
side are inactive. During engineering activities this is not always an advantage. To 
activate the Niagara default views assigned to the hierarchy elements the engineering 
mode has to be activated. 

Procedure

At the PointListViewService hierarchy element use right click Actions menu and select 
Change Mode.

Select Engineering Mode

RESULT: Standard Niagara default views assigned to the hierarchy elements listed in 
the tree on the left side are active. 

Engineering mode can be deactivated using the same menu selecting Live Mode. 

Engineering Mode will automatically be deactivated when user logs off or station is 
restarted.
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8.4 	 Point View Widget Description
This section briefly describes the components and functions of the Point Widget View. 
For descriptions of the numbers assignment, please refer to the corresponding table 
below and on the next page. 

Fig. 1.  Point View Widget Overview

Table 1.  Functions of the Point View Widget

No. Name Functional Description

1 Point View Widget 
Enable

Here you select the Point View Widget from the drop-down listbox for 
displaying the point list.

2 Plant / Folder Name Shows the name of the plant/folder selected in the Nav tree or accessed 
via plant graphic

3 No. of Points Shows the number of points included in the point list

4 Point List In the area below, the point list is displayed 

5 Point Properties Shows the point properties as configured via column toggler (17). 
Point properties can be:
• Label
  Point name
• Value
  Point value
• Logs
  Graphic history icon in case point has a history (11)
• Status
  Auto, manual, or alarm
• Path
  Location of the point
• PointType (disabled by default)
  Point type such as NumericWritable, BooleanWritable, etc.

6 Point Group Shows the point category to which the points belong
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7 Alarm Status Indicator If displayed, the point is in alarm

8 Override Status 
Indicator

If displayed, the point in in manual state and its point value is overridden

9 Label Name / Proper-
tysheet

Shows the point name. By clicking the blue name, the propertysheet displays for 
editing

10 Point Value Allows the direct change of a writable point´s value

11 History Indicator If displayed in the Logs column, the point has a history (history extension as-
signed). By clicking the blue History icon, the chart displays.

12 Point View Mode Allows selecting the source of the points to be displayed. Points can originate in 
the Points folder or its subfolders, or any other folder underneath the driver/net-
work (default view), in a graphic (PX page), or in a favourite

13 Filtering by Status Allows quick display of points which are overridden, or in alarm, or which have 
histories.

14 Filtering by Label Allows searching points by name (label) by entering concatenated strings using 
wildcards.

15 Actions Menu Provides the following actions: 
• Setting points into manual mode
• Setting points into auto mode
• Setting points to fallback value / relinquish default value
• Export points to a CSV file
• Saving points to a favourite

16 Point Selection Here you select the point(s) by clicking the checkboxes

17 Column Toggler Allows configuring the point properties to be displayed columnwise.

18 Group Toggler Allows toggling the point group (showing/hide)

19 Page Browser Allows setting the number of displayed points per page and browsing through the 
list pages

20 Column Sorter Allows ascending and descending sorting of the corresponding column

For detailed descriptions on each component and function, please refer to correspond-
ing subsequent sections.

8.4.1 	 Basic Working Techniques
This section describes general functions of configuration, display and navigation of list. 

Setting Columns Display  
The Column Toggler (17) allows the configuration of the point properties to be dis-
played per column.

1.	 On top right corner, click the ColumnToggler icon  .

2.	 In the drop-down menu, check the point property you want to display in a column. To 
hide a point property, uncheck the property. 
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Expanding and Collapsing Point Groups

Points are arranged in point type groups (6) such as NumericWritable, BooleanWritable 
etc. If a high number of points are arranged in a group and you want to optimize the list 
display for viewing other point type groups on one page, you can use the Group Tog-
gler (18) to collapse a group. As required you can expand the group again by using the 
Group Toggler.

1.	 To collapse a point group, click the down arrow  in front of the group name. 
2.	 To expand a collapsed point group, click the horizontal arrow  in front of the group 

name.

Setting Point Count Display and Page Browsing 

At the bottom of the list, the Page Browser (19) allows setting the number of displayed 
points per page and browsing through the list pages. 

 

1.	 For adjusting the number of displayed points per page, click the right-handed Page 
drop-downlist  and select the number from 20, 40, or 60. 

2.	 For browsing through the list pages, click the forward  and backward  but-
tons or click on the page number. 

Sorting Point Properties in Column

Point properties can be sorted ascending and descending in their columns by using the 
upward/downward arrows (20) right to the column title (property name).
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1.	 To sort the properties in ascending order, click the upward arrow  .
2.	 To sort the properties in descending order, click the downward arrow .

8.4.2 	 Selecting Point View Mode
Points can be located or included in any of the following places in your station:

•	 Points folder and subfolders underneath the device and/or network 
•	 Individual folders underneath the device and/or network 
•	 Any Niagara folder
•	 Graphic (PX) file
•	 Favourites (must first have been created in the Point View Widget)
Referring to this, the following point view modes are selectable:

•	 Default View 
shows all points of the station

•	 Graphic Views 
shows all points used in the selected graphic

•	 Favourites  
shows all points saved in the favourite 

When selecting the point view mode, only the points included in the selected Point 
View are listed in the point list.

By default, the Default View mode is preselected after the points are loaded in the Point 
View Widget.

Procedure

1.	 In the control bar, click the “Point View Mode” drop-down listbox (12), and then click 
the view. 
 

 
 
RESULT.	 The point list is updated according to the selected view. 
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8.4.3 	 Filtering Points
Points can be filtered by their label (name) and status. The filtering functions apply in 
all point view modes: Default view, Graphic views and Favourites.

Please refer to the subsequent sections for detailed descriptions for the two methods.

8.4.3.1 	 Filtering Points by Status
By applying predefined filters (13), points of the current point list can be filtered by the 
following status:

•	 Overridden points
•	 Points with histories (trend points) 
•	 Points in alarm

 

Multiple predefined point filters can be used simultaneously. 

When using more than one filter, the filters will be logically linked with AND. 
That is, for example, when searching for overridden points and points in 
alarm, only those points which fulfil both filter criteria, will be listed. Filters can 
also be applied additionally to the search function as described in the “Filter-
ing Points by Label”. In this case, that filtering logic will be considered addi-
tionally.

Applying a Predefined Filter

1.	 To apply a predefined filter, click the icon, e.g. the Alarm icon . 
 
RESULT: The filter is enabled and the icon toggles to active state indicated by the 
blue color .

2.	 To release a predefined filter, toggle the filter by clicking the Alarm icon  again. 
Example: Filtering for overridden points

Procedure

1.	 To filter for overridden points, click the Overridden icon  in the control bar. 
RESULT: The icon toggles to active state . In the list, only points that are in “over-
ridden” status are displayed. The overridden status of a point is indicated by the 
hand symbol  in front of the point label and by the message “overridden” in the 
Status column

For filtering for points in alarm or with histories, apply the corresponding filter functions 
in the same way.
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8.4.3.2 	 Point Status Indications
The status of a point is indicated graphically (override hand symbol, alarm rectangle) in 
front of the point label and descriptive in the Status column. As an exception, for a point 
with a history, the graphic indication is displayed in the Logs column by a chart symbol.

Graphic Point Status Indications

	Æ Overridden point

 

	Æ Point in alarm 

 

	Æ Point with history

 

The different colors and status descriptions for alarm points are described in the follow-
ing table (see below):

Table 2. Alarm Status and its Color Indications

Color Status Text Cause

Red UnackedAlarm 
 
Alarm

• The current state of the alarm source is OffNormal and the alarm is not 
acknowledged
• The current state of the alarm source is Fault and the alarm is not 
acknowledged

Green UnackedAlarm The current state of the alarm source is Normal and the alarm is not 
acknowledged

Orange Alarm The current state of the alarm source is Normal and the alarm is acknowl-
edged

Yellow Alarm • The current state of the alarm source is OffNormal and the alarm is 
acknowledged
• The current state of the alarm source is Fault and the alarm is acknowl-
edged

White Ok The current state of the alarm source is Normal and the alarm is acknowl-
edged
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8.4.3.3 	 Filtering Points by Label
In the current point list, points can be filtered (searched) by point label (14). This can be 
done by entering simple or concatenated text strings using wildcards.

 

8.4.3.4 	 Procedure
1.	 In the Search by Point Label field, enter the string.  

RESULT: The point list is updated with the found points instantly as you type the 
string.

When using a concatenated text string, the text string parts will be logically 
linked with OR. That is, for example, when entering “temp+set”, any points 
having either “temp” or “set”, or both in their label will be listed. The search 
function can be applied additionally to the status filtering function as de-
scribed in the “Filtering Points by Status” section. In this case, that filtering 
logic will be considered additionally.

Examples: Filtering for points that contain “temp” in its label. In a second step, filtering 
for points that contain “set” in its label.

  
Fig. 2. Searching in point labels using single text string

RESULT.	 All points containing “temp” in its label are listed. 

 
Fig. 3.  Searching in point label using concatenated text string 

RESULT: All points containing “temp” and all points containing “set” in their labels are 
listed. 
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8.4.4 	 Setting Point Values
The value of a point is set by one of the following causes:
•	 Automatic update 

executed by the running application, see “Relinquishing Points” section
•	 Manual override 

Explicitly done by the user, see “Manual Override (Direct Point Editing)” section and 
“Manual Override (Enhanced Point Editing)”.

•	 Fallback value / Relinquish default 
Pre-setting defined by the user, see “Setting Point to Fallback / Relinquish Default 
Value” section.

8.4.4.1 	 Manual Override (Direct Point Editing)
You can manually override the value of a single writable point by changing its value di-
rectly in its Value field (Direct Point Editing). The overridden status is indicated descrip-
tive in the Status column (overridden) and graphically by the hand symbol  in front of 
the point label. In the priority array, the changed value is written to the slots ´In8` and 
´Out`.
Direct point editing allows changing the value of a single writable point in one step. For 
changing values of multiple writable points simultaneously, please refer to the “Manual 
Override (Enhanced Point Editing)”section.

Procedure
In the following steps, NumericWwritable and BooleanWritable points are described as 
examples for direct point editing.
1.	 Overriding Value of NumericWritable Point 

For overriding the value of a single NumericWritable point, click the value in the 
Value column (for overriding the value of a BooleanWritable point, see step 3). 

   
Fig. 4.  Example “Manual Override of NumericWritable Point”

2.	 Enter the value, and then press ENTER key. 

  
 
RESULT:	 The value is overridden. The overridden status is indicated descrip-
tive in the Status column (overridden) and graphically by the hand symbol  in front 
of the point label. At the bottom, the history of point editing is shown in the Updating 
point details… window (see step 4).

3.	 Overriding Value of BooleanWritable Point 
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For overriding the value of a single BooleanWritable point, click the left and right 
edge respectively (depending on the current status) of the binary switch icon  in 
the Value column. 
 

 
Fig. 5.  Example “Manual Override of BooleanWritable Point” 
 
RESULT: The value is overridden. The overridden status is indicated descriptive in 
the Status column (overridden) and graphically by the hand symbol  in front of the 
point label. At the bottom, the history of point editing is shown in the Updating point 
details… window (see step 4). 
 

 

4.	 Viewing Point Editing History 
The Updating point details… window at the bottom shows the actions performed to 
the points and their point labels.  
 

 

5.	 To view details of an edited point, click the down arrow . The point path is displayed 
and a green arrow indicates that the point value has been successfully changed. 
 

 

6.	 To hide the Updating edit point details… window, click the Hide icon .  

7.	 To re-display the Updating edit point details… window, click the View icon .  
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8.4.4.2 	 Manual Override (Enhanced Point Editing)
You can manually override a single writable point or multiple writable points of the 
same group with the same value simultaneously by using the Set to Manual action (En-
hanced Point Editing) in the Actions menu. In addition, enhanced point editing allows 
applying a certain duration the points should stay in manual override. 
The following options are available:

•	 Permanent
•	 1, 15, or 3 minutes
•	 1, 2 or 3 hours
•	 Override expiration: discards current duration
The overridden status is indicated descriptive in the Status column (overridden) and 
graphically by the hand symbol  in front of the point label. In the priority array, the 
changed value is written to the slots ´In8` and ´Out`.

Multiple writable points can have the same or different facets.
Multiple writable Enum points must have the same Enum range.

 

Procedure

In the following steps, NumericWritable and BooleanWritable points are described as 
examples for enhanced point editing.

1.	 Overriding Value of NumericWritable Points 
Select the points you want to override manually by checking the checkbox at the 
point label (for overriding the value of BooleanWritable points, see step 5).  
 

 
Fig. 6.  Example “Manual Override of NumericWritable Points” 

2.	 Click the Actions menu (15) on the top, and then click Set to Manual. 
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RESULT:	 The Override dialog box displays and shows the number of selected 
points. 
 

3.	 In the Override Value field, enter the value, and from the Duration drop-down list, 
select the duration. 
 

    
 

4.	 Click the Save button. 
 
RESULT: Any selectable points are overridden with the new value as indicated in 
the Value column. The overridden status is indicated descriptive in the Status col-
umn (overridden) and graphically by the hand symbol  in front of the point label. 
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At the bottom, the history of point editing is shown in the Updating point details… 
window. 

  
For detailed description of the Updating point details… window, please refer to step 
“Viewing Point Editing History”.

5.	 Overriding Value of BooleanWritable Points  
For overriding BooleanWritable points, please apply the previous steps 1 and 2 in 
the same way as described for the NumericWritable points above. 
 

 
Fig. 7.  Example “Manual Override of BooleanWritable Points”  

6.	 In the Override Value field, select the “false” state, and from the Duration drop-down 
list, select the duration. 

 

7.	 Click the Save button. 
 
RESULT: The points are overridden with the new value as indicated by the toggled 
switch icon  in the Value column. The overridden status is indicated descriptive 
in the Status column (overridden) and graphically by the hand symbol  in front of 
the point label. 
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At the bottom, the history of point editing is shown in the Updating point details… win-
dow.

For detailed description of the Updating point details… window, please refer to step 
“Viewing Point Editing History”.

8.4.4.3 	 Inline Command Editing
The Inline Command option allows to edit point values in the Point View Widget.
Click on the point value opens edit field where new value can be entered.

By pressing the enter key value will be set and point state changes to overridden.

8.4.4.4 	 Inline Command Configuration
8.4.4.4.1 	 Disable Default Override state by Network point type configuration

Point state changes by default to override after point value editing. Automatically de-
fault setting can be disabled via configuration of Point Types.

Procedure
1.	 At the PointListViewService hierarchy element use right click Actions menu and 

select Add Configuration. 
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In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations 
at the PointListViewService right click Actions menu.

2.	 Configuration of Point Types
	- Enter a configuration name, 
	- Select the Network Type
	- Select Point Types where the default override state should be disabled  

		 (multi selection via ‘ctrl’ key) 
	- Press “Save”.

RESULT: For the selected Point Types the default override state after editing the point 
value will not be set. The point state will stay unchanged. I.e. This is the same opera-
tion as in Action Set menu of single point

Points can be configured only grouped per point types not per single point.
Only one configuration per network is possible. i.e. all applying point types 
within the same network have to be in one configuration.
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8.4.4.5 	 Edit existing Configurations
Added Configurations are displayed under the PointListViewService.

For changes double click on the entry and use dialog on the right pane

In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations 
at the PointListViewService right click Actions menu.

8.4.4.6 	 Relinquishing Points
When setting the point value of a point that is in manual override to Auto, the point 
value will be relinquished. In the priority array, the slots ´In 8` and ´Out` will be cleared.
You can relinquish a single writable point or multiple writable points of the same group 
simultaneously. 

Relinquishing multiple points belonging to different groups (e.g. Numer-
icWritable and BooleanWritable) simultaneously is not possible.

 

Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as 
examples for relinquishing points.

1.	 Relinquishing NumericWritable Points  
Select the points, you want to relinquish by checking the checkbox at the point label 
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(for relinquishing the value of BooleanWritable points, see step 4). 
 

 

2.	 Click the Actions menu on the top, and then click Set to Auto. 
 

 
 
RESULT: The Relinquish dialog box displays and shows the number of selected 
points. 
 

 

3.	 Click the Apply button. 
 
RESULT: The points are relinquished to Auto as indicated in the Value column. The 
auto status is indicated descriptive in the Status column (ok). At the front of the 
point label, the overridden hand symbol  is removed. 
 

 

4.	 Relinquishing BooleanWritable Points 
For BooleanWritable points, apply the previous steps 1 through 3 in the same way 
as described for the NumericWritable points above. 
 

 
 
RESULT: The points are relinquished to Auto as indicated by the toggled switch icon 
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 in the Value column. The auto status is indicated descriptive in the Status col-
umn (ok). At the front of the point label, the overridden hand symbol  is removed. 

8.4.4.7 	 Setting Point to Fallback / Relinquish Default Value
By using the Set action of the Actions menu (15), you can write a value to the Fallback 
value (Niagara points) or Relinquish Default (BACnet points) in the priority array. This 
function can be applied to a single writable point or multiple writable points of the same 
group simultaneously. Multiple writable points of the same group can have different 
initial values (true or false).  
Points which are already in the desired state, remain in this state, the others are up-
dated accordingly.

Applying the Set action simultaneously to multiple writable points of differ-
ent groups (e.g. NumericWritable and BooleanWritable) is not possible.

Procedure 
In the following steps, NumericWwritable and BooleanWritable points are described as 
examples for the Set action application.

1.	 Setting NumericWritable Points to Fallback / Relinquish Default Value  
Select the points, of which you want to set the fallback value and relinquish default 
respectively (for setting the value of BooleanWritable points, see step 5). 

2.	 Click the Actions menu (15) on the top, and then click Set. 
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RESULT: The Set dialog box displays and shows the number of selected points. 

3.	 Enter the value. 

 
4.	 Click the Apply button. 

RESULT: The value is set as indicated in the Value column. 
 

  
 
At the bottom, the history of point editing is shown in the Updating point details… 
window.  
 

 
 
For detailed description of the Updating point details… window, please refer to step 
“Viewing Point Editing History” above. 

5.	 Setting BooleanWritable Writable Points to Fallback / Relinquish Default Value  
Please apply the previous steps 1 and 2 in the same way as described for the Nu-
mericWritable points. 
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RESULT: The Set dialog box displays and shows the number of selected points. 

6.	 Select the other value. 

 

7.	 Click the Apply button. 
RESULT: The value is set as indicated in the Value column.  
 

At the bottom, the Updating edit point details… window displays and shows the actions 
performed to the points and their point labels.

At the bottom, the history of point editing is shown in the Updating point details… win-
dow.

 

For detailed description of the Updating point details… window, please refer to step 
“Viewing Point Editing History”.
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8.4.5 	 Saving Points to Favourites
Points of particular interest which should be viewed more often, can be saved into a 
favourite for quick display (fast access list).  
The points to be saved to a favourite can be assorted from any accessible source (see 
“Selecting Point View Mode“ section) and by using any available point filtering method 
(see “Filtering Points“ section). 

Procedure

1.	 Select the points (16), you want to save to a favourite, then click the Actions menu 
(15), and then click Save to Favourites. 
 

 
 
RESULT: The Save to Favourites dialog box displays. 
 

2.	 In the Name field, enter the name. 
 

For the name, any alphanumeric characters and the following characters 
are allowed: - , _. The following characters are not allowed: @ , ! , # , % , 
$ ,.

3.	 Click the Save button. 
 
RESULT: The favourite is saved under Favourites in the View Point Mode menu. To 
view a favourite, please refer to the “Viewing Favourites” section.
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8.4.5.1 	 Viewing Favourites
Procedure

1.	 To view a favourite points list, click the Point View Mode menu, and then click the 
favourite under Favourites. 
 

RESULT:	 The favourite point list is displayed.

8.4.5.2	 Renaming Favourites
Procedure
1.	 To rename a favourite points list, click the Point View Mode menu, and then click 

the Rename icon  right to the favourite. 
 

 
 
RESULT:	 The Rename Favourite dialog box displays. 
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2.	 In the Name field, change the name, and then click the Save button. 
 

 
 
RESULT: The favourite is saved with the new name and available in the Point View 
Mode menu.

8.4.5.3	 Deleting Favourites
Procedure
1.	 To delete a favourite points list, click the Point View Mode menu, and then click the 
Delete icon  right to the favourite. 
 

 
 
RESULT: The Delete Favourite dialog box displays. 
 

2.	 Click the Delete button.

RESULT:	 The favourite is deleted in the Favourites menu.
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8.4.6 	 Exporting Points to CSV
A point list can be exported to an Excel CSV file.

Procedure
1.	 To export a points list to a CSV file, click the Actions menu (15), and then click Ex-
port to CSV.

  
RESULT:	 The complete point list is exported to the CSV file.

Particular individual points cannot be exported to a CSV file.

8.4.7 	 Viewing Point Histories
If a single point has a history assigned by the Niagara history extension, its history can 
be shown graphically.

Procedure
1.	 To view the history of a point, click the History icon  in the Logs column (11). 

  
RESULT:	 The chart of the point is displayed in standard Niagara format. 

2.	 For detailed information on working with charts in Niagara, please refer to the Nia-
gara online documentation. 
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8.4.8 	 Editing Point Properties
The detailed point properties of each individual point can be shown on the property 
sheet. The point properties are shown in the corresponding default view of the prop-
erty sheet. The default views of property sheets are different depending on the origin 
(controller, driver) of the points. That is, the property sheet of a generic Niagara point 
is shown in another default view as a point based on a specific driver. In the following 
procedure, a Niagara point is used as an example.

Procedure

1.	 To display the properties of a point, click the name of the point in the Label column.  
 

 
 
RESULT:	 The property sheet of the point is displayed in its default view.

Fig. 12.  Example “Default View of Niagara Point Property Sheet”

2.	 For detailed information on working with the various property sheets, please refer 
to the corresponding Niagara documentation and the proprietary driver and controller 
documentation.
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8.4.9 	 Delete Points View
•	 The Delete Point View shows an overview of all data points that are not used in the 

project 
-	 Not on a PX page 
-	 No alarm/trend extension 
-	 Not on the wire sheet 
-	 From another application

•	 Applicable for any communication driver
•	 Under Files an xml file is stored, which shows all unused data points including a 

mark if it has already been deleted
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8.5	 Advanced Documentation/Information Section
8.5.1	 Inline Command Configuration adding new Drivers and Point Types

In case if further drivers or data point types are needed for Inline Command Configura-
tion, definitions of further Point Types can be added via editing the configurations file. 

Procedure 
Under Station – Files – config double click on configurations.xml.

See right pane to edit the configuration text.

To apply the changes the file has to be saved and explicit be loaded to the station.

To load the configuration file, go to the PointListViewService hierarchy element use 
right click Actions menu and select Load Configuration.
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A	 Annex

A.1	 Icons

In manuals, this symbol refers the reader to further information in this man-
ual or other manuals or technical information documents. As a rule there is 
no direct link to such documents.

This sign accompanies instructions that must always be followed.

A.2	 Related documents

Document number Document type Document name

26-062 ENGxx Leaflet Release Notes
26-658 GERxx Quick Start FindSymbolsAndMacros
27-668 ENGxx User Guide Point List Widget
27-669 ENGxx Manual Easy Templating for Saia PCD® Supervisor
31-061 ENGxx Flyer Saia PCD® Supervisor
31-703 ENGxx Brochure Saia PCD® Supervisor
34-001 ENGxx Data Sheet Saia PCD® Supervisor

31-702 ENGxx Brochure Saia PCD® Supervisor EM
34-002 ENGxx Data Sheet Saia PCD® Supervisor EM
Easy Features Documentation References
41-0001 User Guide Easy Templating - Installation and Operations Guide
41-0002 User Guide Easy Binding - Installation and Operations Guide
41-0003 User Guide Easy Database  Manager - Installation and Operations Guide
41-0004 User Guide Point List View - Installation and Operations Guide
41-0005 User Guide Easy Alarm Management - Installation and Operations Guide

A.3	 Software-Versions

Book-Version Saia PCD® Supervisor Niagara
27-651 ENG01 Version V1.1 Based on Niagara V4.3
27-651 ENG02 Version V1.2 Based on Niagara V4.7
27-651 ENG03 Version V2.0 Based on Niagara V4.7U1
27-651 ENG04 Version V2.0 Based on Niagara V4.7U1
27-651 ENG05 Version V2.0 Based on Niagara V4.7U1
27-651 ENG06 Version V2.1 Based on Niagara V4.8
27-651 ENG07 Version V2.1 Patch release Based on Niagara V4.9
27-651 ENG08 Version V3.0 Based on Niagara V4.9 
27-651 ENG09 Version V4.10 Based on Niagara V4.10
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A.4	 What is new in V1.2

Name Description See section
Enhanced PG5 Import Wizard Including filtering based on tags from PG5 6.3.8
Point-List-View For straightforward display and management of 

filtered data points
see document 

27-668
Delete Points View Enables simple deletion of all unused data 

points
see document 

27-668
Bulk deploy Mass provisioning of data points in Excel  

(export/import)
7.6

Cloud Connector Action management, performance analytics 7.5
Cyber Security In-depth cyber security measures  

(especially for connecting to the cloud)
see document 

26-624
Energy Monitoring Add-on (including 1-hour demo runtime)
Alarm Consolen Improvments Trend charts and role manager are fully inte-

grated in HTML5
HTML5 extensions Including new Px elements 7.4
Px Editor tools For example for ensuring a responsive design
Improved BACnet Alarming
SMA Reminder Software maintenance reminder
New reporting functions 7.4.1
Multilanguage EN/GE/FR at Niagara level 
Profinet driver 3rd-party module – licence can be acquired 

from Tridium

A.5	 What is new in V2.0

Name Description See section
Point List View Allows to build a basic Supervisor in few minutes See manual: 

27-668 ENGxx
Easy Templating  
for Simple Objects

To automate recurrent tasks and maximise reuse 
SBC Application templates for HVAC to match PG5 
symbols (DDC Suite)

Ch. 6.6.5

Easy Binding Allows the creation basic schematics with lower engi-
neering effort 

Ch. 6.6.5.2

YvkonPro modules The vykonPro modules are an comprehensive collec-
tion of components and px widgets 

Ch 7.7
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A.6	 What is new in V2.1

Name Description See section
Latest Niagara release Niagara 4.8
Easy templating Tool for complex objects See new manual 27-669_ENGxx
Template Library Single Objects 
Mapping table for S-Bus import
Aliasing table for BACNet import
3rd Party Module Signing Requiring all third party modules 

to be signed increases security 
posture of a Niagara installation 

Analytics 7 existing standard reports for 
meaningful output 

E-Signature Supports site procedures typically 
when controlling the manufactur-
ing of food or pharmaceuticals 

JSON Toolkit Enables the connection to IoT 
Software and 3rd Party applica-
tions, cloud services and data-
bases 

Milestone Camera Driver Milestone Systems is a leading 
provider of open platform video 
management software 

Point Database Manager 
(PDM)

Saves overall license costs

Easy Binding Own graphics (design agency) can 
be quickly integrated 

Predefined application and 
project templates

Decreases the engineering time

Multilanguage EN/GE/FR At Niagara level. 
Guest access / Kiosk mode Available from Core Niagara but is 

not usable by SBC  
(Usable for Niagara based control-
lers).

IEEE 802.1x Registration in computer networks
Security Dashboard

A.7	 What is new in V3.0

Name Description See section
Next Niagara release Niagara 4.9
Easy Templating tool Tool for complex objects See new manual 41-00001
Easy Binding tool Own graphics (design agency) can be 

quickly integrated
See new manual 41-00002

Easy Database Manager Remove unused data points to reduce 
license costs. Saves overall license cost.
Enables optimal station performance for 
critical infrastructure projects (data centre)

See new manual 41-00003

Point List View Tool for complex objects See new manual 41-00004
Easy Alarm Management Tool for complex objects See new manual 41-00005
User login preferences Option to define & save customized login 

parameters as per user reference
See section 7.8

Enhanced BACnet support Added BACnet driver with server and client 
support. 
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Name Description See section
Assigned memory to the 
Workbench and station.

Memory space assigned to the Workbench 
and station can be increased to enhance 
the performance

6.1.5

Improved read timeout Introduced new Headstation & Substation 
Ping Read Timeout property slots with 
increased read timeout

7.9

New UDP config slot for 
every headstation

Use of UDP config slot in every headsta-
tion help to enhance the communication 
speed and performance. 

7.10

DDC-Suite 2.7 Templates Comprehensive application library suitable 
for DDC-Suite 2.7 (S-Bus and BACnet)

Cyber Security Dashboard Systemwide view of your current security 
layer 
Built in recommendation for action to be 
taken to improve security for supervisor

Station Template Predefined HTML5 web browser view  
Station Template for Supervisor to provide 
clear arranged menu.

Video & Camera Integration Open video framework solution designed to 
integrate diverse manufacturer devices and 
protocols into a unified video management

Energy Monitoring Easy understanding to handle the tool / 
Customer friendly Energy monitoring chart 
or views

A.8	 What is new in V4.10

Name Description See section
Next Niagara release Next more stable Niagara 4.10 version
Easy Templating tool Improved next version. 

Tool for complex objects
See new manual 41-00001

Easy Binding tool Improved next version.
Own graphics (design agency) can be 
quickly integrated

See new manual 41-00002

Easy Database Manager Improved next version.
Remove unused data points to reduce 
license costs. Saves overall license cost.
Enables optimal station performance for 
critical infrastructure projects (data centre)

See new manual 41-00003

Point List View Improved next version.
Tool for complex objects

See new manual 41-00004

Easy Alarm Management Improved next version.
Tool for complex objects

See new manual 41-00005
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A.8	 List of known issues with the Version V4.10

Key Description of the issue Planned correction 
Saia PCD® Supervisor

GALEO-46277 SBC: Create a Easy Template on a PX page and User 
will not see the Graphics for the first time .

4.11

GALEO-46026 SBC: Easy Healthy Building Service is not available in the 
service list by default

4.11

GALEO-46410 SBC:PLV: After the station restart most of the Bacnet 
point state showing as stale

4.11

GALEO-46805 Complex template standard popup graphic view is not 
loading proper in Webview

4.11

GALEO-46422 SBC: Easy Template - Standard Popup using Kitpx popup 
binding is not working in Web client for both Simple & 
Complex Template

4.11

GALEO-46731 Point List View is not loading in default with Standard 
Popup Template in Browser view

4.11

GALEO-49323 IQVISION 2.6 SP1 - Easy Binding - User is not getting 
any exception message when wrong datatype point is 
binding to an Easy binding widget

4.11

GALEO-43266 HB: CLNX: ".SVG" images are not getting loaded in the 
Building image of Healthy Building Dashboard

4.11

GALEO-49413 4.10u1: EDM - Point used in Tag based Px page showing 
in step 4 of EDM wizard without selecting the appropriate 
option in Step 2 or Step 3.

4.11

GALEO-49433 4.10u1: Not able to navigate to step 4 when history Im-
ports option is selected in step 3 of EDM wizard

4.11

GALEO-49434 EDM- Documentation update is required for "point with 
Linked Plot reference" 

4.11

GALEO-46423 SBC: Easy Template - PX page created using Custom 
Popup option is not viewable in Web Client view for both 
simple template and complex template

4.11

GALEO-14925 SBC - Threshold notification alarm of trend log object is 
not reporting as alert alarm instead of is reporting normal/
unack alarm in supervisor

4.11

GALEO-14465 SBC 2.0-BACNET: The AI, BI & MSI point write opera-
tion ( Out of service) is not working through set operation 
mode

4.11

GALEO-12173 SBC - User specified name is not applying for special 
events (schedule)

4.11

GALEO-12157 SBC - AV, BV & MSV objects has captured random value 
in priority- 16

4.11

GALEO-12155 SBC - Non commendable objects are allowing to perform 
all the override function (Override & Emergency override)
via action call

4.11

GALEO-12146 SBC - Override status and manual flag set is not working 
while doing override operation in commandable objects

4.11

GALEO-11943 SBC:- Calendar and Schedule feature are not working in 
4.7.109.20 .

4.11

GALEO-8650 SBC supervisor N4.4_U1 not able to write any values for 
animated images in any browser

4.11

GALEO-7648 Bacnet Objects like Binary ,Analog,Multistate schedules 
are not working in SBC supervisor

4.11
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Key Description of the issue Planned correction 
Saia PCD® Supervisor

GALEO-4546 SBC Supervisor PSIRT Patch - Selected Datapoints are 
not importing while performing the import from Chrome

4.11

GALEO-3507 SBC Station template does not have the heap max of 1 
GB by default

4.11

GALEO-3488 SBC Import Wizard - Alarm Lists were failed to import but 
detailed report displays wrong informations

4.11

GALEO-3093 SBC Import Wizard - Print button is not enabled in All 
Detailed Report Page

4.11

GALEO-2886 SBC Bacnet Alarms - Alarm time stamp is displayed 
wrong when PCD and PC are in different time zone

4.11

GALEO-2710 SBC Import Wizard - Dynamic refreshing is not working 
as expected in Datapoints screen

4.11

GALEO-2589 SBC Alarms - Ack all alarms (40 alarms) from Alarm con-
sole to Substation does not work

4.11

A.9	 Using the Extended Support Options
Saia PCD® Supervisor is now provisioned with multiple extended support options that 
can be purchased:

Refer to the Saia-PCD-Supervisor Data Sheet (34-001) to know more about available 
extended support options.

In order to use these options it is necessary to license Saia PCD® Supervisor with the 
appropriate license. 
See chapter 5 Licensing Saia PCD® Supervisor

For details of configuring and using these option refer to the Saia Burgess Controls 
documentation.
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A.10	 Contact
Saia-Burgess Controls AG 
Bahnhofstrasse 18 
3280 Murten 
Switzerland 

Phone.......................................  +41  26 580 30 00
Phone support..........................  +41  26 580 31 00
Fax...........................................  +41  26 580 34 99 

Email support: .........................  support@saia-pcd.com  
Supportsite: .............................  www.sbc-support.com  
SBC site: .................................  www.saia-pcd.com  

International Represetatives &  
SBC Sales Companies: ..........  www.saia-pcd.com/contact 

Saia Burgess Controls Technical Support are only able to provide support for 
Saia PCD® Supervisor and the Saia Burgess Controls driver features described in this 
manual. They are unable to provide support for 3rd party drivers and undocumented 
aspects of Saia PCD® Supervisor’s operation.

mailto:support%40saia-pcd.com?subject=Feedback%20from%20the%20manual%2027-651_ENG07
http://www.sbc-support.com
http://www.saia-pcd.com
http://www.saia-pcd.com/contact
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